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Copyrights and Trademarks 
Microsoft, Windows CE .NET, Windows NT, Windows 2000, Windows XP, Visual C++, eMbedded Visual 
C++, Visual Basic and Visual Studio .NET 2003 are either trademarks or registered trademarks of the 
Microsoft Corporation. 

Other products or company names mentioned herein may be the trademarks or registered trademarks of 
their respective companies. 

Reproduction Rights 
This manual contains proprietary information. Permission to reproduce or otherwise use portions of the 
material presented herein is explicitly given to TURCK incorporating the BL ident-Handheld into their 
products. Please note that this publication contains material that may not be appropriate for disclosure to 
some end users and that TURCK assumes no responsibility for technical support burdens incurred, or 
any other consequences of VAR documentation decisions. 

Changes and Addendum 
Since TURCK  is continuously improving the functionality and quality of its products, certain 
information may not be included in this manual at its time of release. As a result, TURCK may provide 
changed material as separate sheets included with this manual or separately in the form of a change 
package, as it deems necessary. 
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Warranty Information 
Seller warrants that the product specified in this agreement is free of defects in materials and 
workmanship, and shall conform to the latest specifications published prior to Buyer’s acceptance of the 
agreement for a period of two years. 
Product specifications as defined supersede previous specifications and are complete. Any parameter 
that is not specifically defined in the specifications is expressly excluded from the warranty. This 
warranty does not apply to any product which has been subject to misuse, accident, alteration, or if the unit 
has been serviced by anyone other than an authorized representative of Seller. 

Seller’s sole obligation to Buyer for products failing to meet specifications shall be, at Seller’s discretion, to 
repair or replace the non-conforming device. 

After receiving a Return Material Authorization (RMA) number and a mailing address from Seller, a 
defective unit covered under this warranty may be returned freight prepaid. Any replacement or 
repaired product shall carry only the unexpired term of the warranty plus any period required for 
repair. 

If Buyer has been expressly designated as an Original Equipment Manufacturer (OEM) by Seller, the 
warranty period shall commence upon the earlier date of (i) delivery to Buyer’s first customer, or (ii) 
180 days from the original date of shipment by Seller. In the events that products for which: (a) Buyer has 
title and, (b) have never been used, and (c) have been in the Buyer’s possession for more than 180 days 
and, (d) have an unaltered date code attached, may for an established fixed fee which will not 
exceed ten percent (10%) of the original purchase price, have the date code updated by the Seller and 
thereby reestablish those products with a new warranty. 

THE FOREGOING WARRANTY AND REMEDIES ARE EXCLUSIVE AND ARE MADE EXPRESSLY IN 
LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED, EITHER IN FACT OR BY 
OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING WARRANTIES OR 
MERCHANTABILITY AND FITNESS FOR USE. TURCK NEITHER ASSUMES NOR AUTHORIZES 
ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN CONNECTION WITH THE 
SALE, INSTALLATION OR USE OF ITS PRODUCTS AND TURCK MAKES NO WARRANTY 
WHATSOEVER FOR PRODUCTS NOT MANUFACTURED BY TURCK. 

TURCK SHALL NOT BE LIABLE FOR DAMAGES DUE TO DELAYS IN DELIVERIES OR USE AND 
SHALL IN NO EVENT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY 
KIND, WHETHER ARISING FROM CONTRACT, TORT OR NEGLIGENCE, INCLUDING, BUT NOT 
LIMITED TO, LOSS OF PROFITS, LOSS OF GOOD WILL, OVERHEAD OR OTHER LIKE DAMAGES. 

To maintain your warranty and to avoid creating hazards, only qualified personnel should perform 
authorized modifications to TURCK products. TURCK cannot assume responsibility for any condition 
affecting the proper operation of this equipment that may result from unauthorized modifications. 

Product Returns 
If, after inspection, you note any product damage or discrepancies, please contact us promptly within 
five days of receipt. If the exterior of the package shows obvious signs of damage, please contact your 
carrier directly. 

All items returned to TURCK require a Return Material Authorization number (RMA). Please contact 
TURCK’ Service department to request an RMA number. 
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Regulatory Notices 
FCC Part 15 Class A 
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense. 

FCC Part 15.225 (15C) 
Registration Number: RYJJETTRFID-1356 

Canadian Department of Communications 
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital 
apparatus set out in the Radio Interference Regulations of the Canadian Department of 
Communications 

Le present appareil numerique n’emet pas de bruits radioelectrique depassant les limites applicables 
aux appareils numeriques de la class A prescrites dans le Reglement sur ie broullage radioelectrique 
edicte par le ministere des Communications du Canada. 

Industry Canada RSS-210 6.2.2(e), 2001 

Certifications 
CENELEC 

 

EMI Standards: 
• EN 55022:1998 (CISPR22), Class A 
• EN 55022/IEC 61000-4-6 
• ETSI EN 300 330-2: 2001  

EMC Standards: 
• EN 55024: 1998 
• ETSI EN 301489-1: 2002 
• ETSI EN 301489-3: 2002 

 ~ EN/IEC 61000-4-2 
 ~ EN/IEC 61000-4-3 
 ~ EN/IEC 61000-4-4  
Safety Standards: 

• EN 60950: 2000 
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Warnings 
Changes or modifications to this unit not expressly approved by the party responsible for regulatory 
compliance could void the user's authority to operate the equipment. 

Operation 
Do not enable or utilize the RFID module while charging the unit. Operation of this nature is 
likely to cause harmful interference. 
Ne permettez pas ou n'utilisez pas le module de RFID tout en chargeant l'unité. L'opération de 
cette nature est susceptible de causer l'interférence nocive. 

No permita ni utilice el módulo de RFID mientras que carga la unidad. La operación de esta 
naturaleza es probable causar interferencia dañosa. 

Lassen Sie das RFID-Modul während des Aufladens des Geräts uneingeschaltet. Ein Betrieb 
während des Aufladens verursacht mit groβer Wahrscheinlichkeit schädliche Störungen. 

Electrostatic Discharge (ESD) 
Electrostatic discharge (static electricity) can have unpredictable adverse effects on any 
electronic device. Although the design of this product incorporates extensive ESD-related 
precautions, ESD can still cause problems. It is good practice to discharge static by touching a 
grounded metal object before inserting cards or connecting devices. 
La descarga electrostática (electricidad estática) puede tener efectos nocivos imprevisibles en 
cualquier dispositivo electrónico. Aunque el diseño de este producto incorpora precauciones 
ESD-relacionadas extensas, la lata de ESD todavía causa problemas. Es buena práctica 
descargar parásitos atmosféricos tocando un objeto puesto a tierra del metal antes de insertar 
tarjetas o de conectar los dispositivos. 
La décharge électrostatique (l'électricité statique) peut avoir des effets nuisibles imprévisibles 
sur n'importe quel dispositif électronique. Bien que la conception de ce produit incorpore des 
précautions ESD-connexes étendues, le bidon d'ESD posent toujours des problèmes. Il est dans de 
bons habitudes de décharger la charge statique en touchant un objet au sol en métal avant 
d'insérer des cartes ou relier des dispositifs. 

Elektrostatische Entladung (statische Elektrizität) kann unvorhersehbare schädliche Wirkungen auf 
elektronische Geräte haben. Obwohl das Gerät mit verschiedenen und umfangreichen ESD-bezogenen 
Schutzeinrichtungen versehen ist, kann es doch zu ESD-Problemen kommen. Sorgen Sie vor dem 
Einsetzen von Karten oder dem Anschluss von Geräten durch Berühren eines geerdeten 
Metallgegenstands immer für eine statische Entladung. 

Battery Replacement 
CAUTION! There is a risk of explosion if you replace the NiMH battery with an incorrect type. 
Only use the NiMH battery supplied with your unit or a replacement NiMH battery supplied, 
recommended, or approved by TURCK, Inc. 
PRECAUCIÓN! Hay un riesgo de la explosión si usted substituye la batería de NiMH por un 
tipo incorrecto. Utilice solamente la batería de NiMH provista de su unidad o una batería de 
NiMH del reemplazo provista, recomendada, o aprobada por TURCK, Inc. 
ATTENTION! Il y a un risque d'explosion si vous remplacez la batterie de NiMH avec un type 
incorrect. Utilisez seulement la batterie de NiMH fournie avec votre unité ou une batterie de 
NiMH de remplacement fournie, recommandée, ou approuvée par TURCK, Inc. 
VORSICHT! Bei Verwendung von NiMH-Batterien, die nicht von TURCK, Inc. geliefert, empfohlen 
oder genehmigt wurden, besteht Explosionsgefahr! Benutzen Sie daher nur solche NiMH-Batterien, 
die mit dem Gerät geliefert wurden, oder Batterien, die von TURCK, geliefert, empfohlen oder 
genehmigt wurden. 
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Battery Disposal 
Dispose of batteries in a safe manner. The following are general guidelines for the safe use and 
disposal of NiMH batteries: 
Replace a defective NiMH battery immediately as it could damage the unit. 

Do not throw the NiMH battery it in trash that is disposed of in landfills as it contains heavy 
metals. Recycle or dispose the NiMH battery of it as required by local ordinances or 
regulations. 
Do not disassemble, incinerate, short-circuit the NiMH battery or throw it into a fire. It can 
explode and cause severe personal injury. 

Excessive discharge damages a NiMH battery. Recharge the NiMH battery when your unit 
indicates low battery power. 
Disponga de las baterías de una manera segura. Los siguientes son pautas generales para el uso 
seguro y la disposición de las baterías de NiMH: 
Substituya una batería defectuosa de NiMH inmediatamente pues podría dañar la unidad. 

No lance la batería de NiMH él en la basura que se dispone en terraplenes mientras que 
contiene los metales pesados. Recicle o disponga la batería de NiMH de ella según los 
requisitos de ordenanzas o de regulaciones locales. 

No desmonte, no incinere, no cortocircuitos la batería de NiMH ni láncela en un fuego. Puede 
estallar y causar daños corporales severos. 
La descarga excesiva daña una batería de NiMH. Recargue la batería de NiMH cuando su 
unidad indica energía de batería baja. 
Débarassez-vous des batteries d'une façon sûre. Ce qui suit sont les orientations à l'utilisation 
sûre et à la disposition des batteries de NiMH: 
Remplacez une batterie défectueuse de NiMH immédiatement car elle pourrait endommager 
l'unité. 
Ne jetez pas la batterie de NiMH il dans le détritus qui est débarassé en remblais pendant qu'il 
contient les métaux lourds. Réutilisez ou disposez la batterie de NiMH d'elle selon les exigences 
des ordonnances ou des règlements locaux. 

Ne démontez pas, n'incinérez pas, ne court-circuitez pas la batterie de NiMH ou ne la jetez pas 
dans un feu. Il peut éclater et causer des blessures graves. 
La décharge excessive endommage une batterie de NiMH. Rechargez la batterie de NiMH 
quand votre unité indique la basse puissance de batterie. 

Entsorgen Sie die Batterien auf eine sichere Weise. Die folgenden Regeln sind allgemeine Richtlinien 
für den sicheren Gebrauch und die sichere Entsorgung der NiMH-Batterien: 
Ersetzen Sie eine defekte NiMH Batterie sofort, da sie das Gerät beschädigen könnte. 
Die NiMH-Batterien enthalten Schwermetalle. Werfen Sie die Batterien daher nicht in den 
Hausmüll, der in normalen Deponien abgeladen wird, sondern entsorgen Sie sie gemäβ den 
geltenden lokalen Vorschriften für Sondermüll. 
Bauen Sie die Batterien nicht auseinander, zünden Sie sie nicht an, schließen Sie sie nicht kurz und 
werfen Sie diese nichts ins Feuer. Sie können explodieren und ernste Verletzungen verursachen. 

Eine übermäßige Entladung beschädigt eine NiMH-Batterie. Laden Sie die NiMH-Batterie neu, 
wenn auf dem Geräte eine niedrige Batterieleistung angezeigt wird. 

Servicing Information 
When servicing the unit, the plug (BL ident connect cable) is the disconnect device. Simply 
unplug the unit before servicing. 
Al mantener la unidad, el enchufe (cable de BL ident connect) es el dispositivo de la desconexión. 
Desenchufe simplemente la unidad antes de mantener. 
En entretenant l'unité, la prise (câble de BL ident connect) est le dispositif de débranchement. 
Débranchez simplement l'unité avant l'entretien. 
Vor der Wartung des Geräts ist der Stecker (BL ident-Anschlussleitung) zu ziehen.. 
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Chapter 1: Overview 

About this Manual 
Intended for authorized developers with prior knowledge of Windows CE .NET and hand held PC 
application development using eMbedded Visual C++ and Visual Studio .NET, this manual describes the 
advanced features, operations and interface capabilities of TURCK’ BL ident-Handheld. It is not for use 
by end-users. 

Because the BL ident-Handheld is a highly customizable product with many optional configurations 
and special keypad layouts, this manual only describes the standard features and operation of the 
BL ident-Handheld. For custom configurations and special options, consult the appropriate 
supplemental manual or addendum. 

Unless otherwise stated, the operational characteristics described herein correspond to factory default 
configurations and settings as shipped from TURCK. Wherever used herein, the term “BL ident-
Handheld” applies to all models (except as noted). 
It is beyond the scope of this manual to provide operating system tutorials or information about 
commercial or customized BL ident-Handheldapplication programs and connected equipment. 
This information should be available in the manuals that accompany those products. 

About RFID 
RFID (Radio Frequency IDentification) is a wireless communication technology that uses the RF portion of 
the electromagnetic spectrum to transmit and receive information from EPC (Electronic Product Code) 
tags. The tags can come in many shapes and sizes, such as disks, cards or paper labels (smart labels) and 
can store a simple identification number or a sophisticated database. 

RFID technology is based on the simple idea that a reader can activate an electronic circuit inside a tag 
from a distance and exchange information. An integrated circuit inside the reader creates an alternating 
current. This current generates an alternating magnetic field through the reader’s antenna that serves as a 
power source for a RFID tag. This magnetic field interacts with the antenna in the tag, which in turn, 
activates the tag’s integrated circuit causing the tag to create a digital signal, which contains an encoded 
identifier number. 

The tag then generates its own alternating magnetic field, which interacts with the reader’s alternating 
magnetic field. A device inside the RFID reader senses the variations and converts this pattern to the 
digital signal, which interprets the tag's identifier code. 
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About the BL ident-Handheld 
With its modern, ergonomic appearance and design, the BL ident-Handheld is the most recent addition to 
TURCK' series of rugged hand held computers for industrial and commercial use. Its quick mount 
connector system allows easy insertion and removal in cradle or vehicle mounts. 

Designed for one-handed operation, the BL ident-Handheld features a powerful Microsoft Windows CE 
.NET 4.2 operating system, Intel XScale Technology Processor, color sunlight readable display with 
touch screen technology. 

With its powerful 13.56 MHz RFID integrated reader and flip-out antenna, the BL ident-Handheld can read 
and write most industry standard RFID tags within a 3.5 inch (80 mm) range making it ideal for 
“contactless” payments, item tracking and data collection. 

The following table shows the RFID tag types and functionality supported by the BL ident-

Handheld. Table 1-1: Tag Compatibility Chart 

Specification Manufacturer Tag Type Anti-Collision Read Write 
Infineon my-d SRF55V10P Yes Yes Yes 

ST Microelectronics LR512 Yes Yes Yes 

ISO-15693 

Texas Instruments Tag-It HF-I Yes Yes Yes 

Inside Contactless PicoTag 2K No ID Only* No 

Philips I-Code1 (SL1) Yes Yes Yes 

TagSys GemWave C210 Yes ID Only * No 

Proprietary 

Texas Instruments Tag-It HF Yes Yes Yes  
* Cannot read ID using AutoDetect 

 

BL ident  – Handheld Features  

Rechargeable Battery Pack 
The BL ident-Handheld comes with a rechargeable Nickel Metal Hydride (NiMH) battery pack that can 
provide up to twelve hours of operating time on a full charge (depending on power management and 
use). The NiMH technology used in the BL ident-Handheld has exceptional charge life without the 
“charge memory” characteristic of conventional nickel cadmium batteries. Partially discharged batteries 
or extended periods with the charger left connected will not adversely affect battery life or performance. 
The BL ident-Handheld can also run on six AA Alkaline batteries. 

Operating System 
The BL ident-Handheld uses Windows CE .NET Professional 4.2 as its operating system. You can 
develop applications quickly and easily using the latest development tools and network connectivity 
from Microsoft, such as eMbedded Visual C++ 4.O, Visual Studio .NET 2003 and ActiveSync 3.7. 

Processor 
The BL ident-Handheld utilizes an Intel PXA255 processor with XScale technology at 200MHz 
(400MHz optional) .The Intel PXA255 processor is a highly integrated, 32-bit RISC processor that 
combines the efficiency of Intel design with the ARM v.5TE instruction set architecture. 

Memory and Mass Storage 
The BL ident-Handheld comes standard with 64MB of SDRAM and 64MB (approximately 16MB used 
for operating system) of internal compact flash memory, which is expandable to 128MB. For removable 
data storage or I/O cards, the BL ident-Handheld is equipped with a Compact Flash (CF) slot. 
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Displays 
The BL ident-Handheld features a supertwist nematic liquid crystal 320 x 240 QVGA-TFT color 
sunlight readable display with options for a touch screen and LED backlight. 

Keypads 
Standard keypad configurations for the BL ident-Handheld include 15-key, 30-key, and 45-key 
elastomeric keypads and a 45-key membrane keypad. All standard keypad configurations have an option 
for LED backlighting. 

Indicators 
The BL ident-Handheld has five programmable LED indicators that can provide a number of useful 
functions including the state of keypad modifier keys. An additional LED indicates the charge and low 
battery statuses. 

Interface Capabilities 
The BL ident-Handheld comes standard with one available serial port configured for RS-232 that can 
also provide input power (11–18VDC) and recharging capability. Several interface connectors are 
available at time of factory configuration, including the BL ident connect system, DE-9 male or female 
connectors and a six-pin modular connector. 

Interface connections can optionally provide output at 5 VDC to operate peripheral devices at time of 
factory configuration. 

Durability 
The case is made of General Electric Xenoy, one of the most durable chemical resistant materials 
available today. 
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Chapter 2: Getting Started 

Front Components and Indicators 
This section describes the components and indicators found on the font of the BL ident-Handheld. 
Figure 2-1: Front Components and Indicators 

 
Table 2-1: Front Components and Indicators 

Item Function Description 
1 Display Supertwist nematic liquid crystal display with touch screen 
2 Battery Indicator Indicates low battery (red) status and charging (green) status 
3 LEDs Indicates use of the SHIFT, CTRL, 2ND ALT and CAPS modifier keys 
4 On/Off Switch Controls the Power, Suspend and Resume operations 
5 Keypad Standard 45-key keypad (30 and 15-key keypads not shown) 
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Rear Components 
This section describes the components found on the rear of the BL ident-Handheld. 

Figure 2-2: Rear Components 

 
Item Function Description 

1 RFID Module The RFID Module attached to the rear of the unit can read RFID tags 
in its storage position (show above) or swing out up to 180 degrees 
for maximum range. See Figure 3-10. 

2 Battery 
Compartment 

The battery compartment can store either the Nickel Metal Hydride 
rechargeable battery pack or six AA Alkaline batteries. You can 
access the battery compartment by lifting up and turning the 
retaining clip. 
For more information using batteries, see Battery-Powered 
Operation. 
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Compact Flash Slot Cover 
The standard compact flash slot cover located on the top of the unit provides access to the compact flash 
slot that stores memory and device cards. In addition to the standard cover, a modified cover and a sealed 
cover are also available. 

The modified cover (Figure 2-5) has a machined opening that allows you to easily insert and remove 
devices cards that exceed 1.437 inches in height. 

The sealed cover (Figure 2-6) has a set of tamper-proof 1-32 x 1/4" long Torx screws to restrict access to the 
compact flash slot. The sealed cover also provides additional protection against the elements. 

To remove the Torx screws requires an IP6 Torx (T6) driver, which you can purchase from TURCK 
(Part Number 14170) or McMaster-Carr (Part Number 5259A11). 

You can also purchase additional Torx screws from TURCK (Part Number 14168) or Camcar (Part Number 
3BE-P8240-00). 

For more information about inserting and removing memory and device cards, see Inserting and 
Removing Cards. 

Figure 2-3: Standard Compact Flash Slot Cover in Closed Position 

 

Figure 2-4: Standard Compact Flash Slot Cover in Open Position 

Fig ure 2-5: Modified Compact Flash Slot Cover for Long Device Cards 

Figure 2-6: Sealed Compact Flash Slot Cover 
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Interface Connections 
This section describes the interface connectors found on the bottom of the BL ident-Handheld. 

BL ident  connect System 
The BL ident connect system is a set of rugged interface and cable connectors especially designed for 
industrial environments. It features positive connector retention without any hardware restraints for 
quick connect/disconnect operations and a contact design that prevents failure due to pin fatigue and 
cable stress after repeated use. 
Figure 2-7: BL ident Interface Connector 

 

DE-9 Connectors 
The DE-9 connectors emulate standard serial pin-out connections, and allow you to connect the BL 
ident-Handheld to most desktop PCs using a standard null modem cable. 

Figure 2-8: DE-9 Male Interface Connector 

 2 4 6 8 1 0 1 2 RS-232 Interface Pin-Outs 
Pin 1 = X1 Pin 7 = DSR 

Pin 2 = Ground Pin 8 = RTS 

Pin 3 = RI Pin 9 = DCD 

Pin 4 = CTS Pin 10 = 11-18VDC Input 

Pin 5 = DTR Pin 11 = Shield 

Pin 6 = TXD Pin 12 = RXD  
Viewed facing connector 

 

Figure 2-9: DE-9 Female Interface Connector 

 

 RS-232 Interface Pin-Outs 
  Pin 1 = DCD   Pin 6 = DSR 

Pin 2 = RXD  Pin 7 = RTS 

Pin 3 = TXD  Pin 8 = CTS 

Pin 4 = DTR  Pin 9 = 11-18VDC Input 

Pin 5 = Ground   

 RS-232 Interface Pin-Outs 
Pin 1 = DTR Pin 6 = DTR 

Pin 2 = TXD    Pin 7 = CTS 

Pin 3 = RXD    Pin 8 = RTS 

Pin 4 = DSR/DCD    Pin 9 = 11-18VDC Input 

Pin 5 = Ground  
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6-Pin Modular  Connector  
Despite its physical similarity to a telephone jack, the 6-pin modular connector is not compatible with 
telephone lines or signals. Connecting the BL ident-Handheld to a telephone line will damage it and void 
the warranty. 

Figure 2-10: 6-Pin Modular Interface Connector 

 

 

Viewed facing connector 

Power Jack 
The optional power jack found on the bottom of the BL ident-Handheld enables you to connect an 11-18 
VDC Input power supply battery charger, such as TURCK #14508. Use of other power supplies unless 
approved by TURCK may cause damage to the unit and void the warranty. 

Figure 2-11: Power Jack 

 

Power Supplies, Cables and Adapters 
TURCK can provide the following optional power supplies, cable and adapters based on communication 
and power requirements. For cable signal and pin assignments, see Appendix B: Signal and Pin 
Assignments. 
Table 2-3: Available Power Supplies, Cables and Adapters 

TURCK 
Part Number Part Description 

14508 11–18VDC Power Supply (North America Only) 1 

91708 Black, 15-Foot BL ident connect Cable (DE-9 Male) 

91709 Black, 15-Foot BL ident connect Cable (DE-9 Female) 

1210-7-BK Black, 7-Foot Coiled Modular-to-Modular Cable 

1210-15-BK Black, 15-Foot Coiled Modular-to-Modular Cable 

14375 Black, 15-Foot Null Modem Cable (DE9 Female to DE9 Female) 

CELAT-P Modular Cable to DE-9 Cable Adapter  
1. Use of other power supplies unless approved by TURCK may cause damage to the unit and void the warranty. 

RS-232 Interface Pin-Outs 
Pin 1 = 11-18 VDC Input 

Pin 2 = CTS  

Pin 3 = RTS  

Pin 4 = TXD  

Pin 5 = RXD  

Pin 6 = Ground 

  

V i e we d  f a c i n g  c o n n e c t o r  
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Chapter 3: Operation 

Power 
The BL ident-Handheld comes with a rechargeable Nickel Metal Hydride (NiMH) battery pack that can 
provide up to twelve hours of operating time on a full charge (depending on power management and 
use). This battery is fully charged and installed in the unit when shipped. However, because some 
battery dissipation occurs between the time when the unit ships and when you start using it, you should 
charge the unit for approximately four hours before using it without the battery charger/power supply 
connected. 

Charging the Unit  
The nickel metal hydride battery technology used in the BL ident-Handheld has exceptional charge life 
without the “charge memory” characteristic of conventional nickel cadmium batteries. Partially 
discharged batteries or extended periods with the charger left connected will not adversely affect battery 
life or performance. 

Warning! Do not enable or utilize the RFID module while charging the unit. Operation of this nature is likely to 
cause harmful interference. 

Note: Because the internal battery charger senses several conditions, including temperature, you should 
charge the unit away from any known or potential heat sources. Units exposed to temperatures in excess of 
110 degrees Fahrenheit during the charge cycle may experience incomplete charging and reduced 
operating time per charge. 

To charge the NiMH battery pack: 

1. Depending on your configuration, plug the power jack of the battery charger/power supply 
into the corresponding cables connector and/or adaptors as shown below. 

Figure 3-1: Using 91708, 91709, and14375 Cables 

 

Figure 3-2: Using 1210 Series Cables 

 
Power Supply/Battery Charger
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2. Plug the interface cable into the connector on the bottom of the BL ident-Handheld. If your 
unit has a power jack receptacle on the bottom of your BL ident-Handheld, just plug the 
power jack into that receptacle. 

3. Plug the battery charger/power supply into a power outlet. The Charge LED should turn on, 
indicating that the batteries are charging (see Table 3-1). 

Figure 3-3: Power Supply

4. Once the battery is fully charged (approximately four hours), you can disconnect the A 
power supply and run the BL ident-Handheld exclusively on battery power. 

Charge/Low Battery Indicator 
When using the NiMH battery pack, the CHARGE/LOW BAT LED will indicate the current battery 
status as shown in the table below. 

Figure 3-4: Charge/Low Battery Indicator 

 
Table 3-1: Charge\Low Battery Indicator Functions 

Function Description 
CHARGE With the power supply connected, the CHARGE/LOW BAT LED will indicate one of 

following conditions: 

 

~ High Power Charge—the LED will turn solid green 
~ Fully/Near Full Charge—the LED will blink green about four times a second 
~ Trickle Charge —the LED will blink green approximately once per second 

when either the battery voltage and/or temperature of the battery assembly 
are not within acceptable limits 

LOW BAT 
With the power supply disconnected, the CHARGE/LOW BAT LED will indicate one 
of following conditions: 

~ Batteries are low— the CHARGE/LOW BAT LED will blink red once per 
second when there is approximately 60 minutes of power remaining 

~ Batteries are very low—the CHARGE/LOW BAT LED will turn solid red 
when there is approximately 10 minutes of power is remaining 
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Power/Suspend Switch 
The On/Off switch is located above the keypad. Its function depends on the state of the BL ident-
Handheld at the time the switch is pressed and on the length of time that the switch is depressed. 
Operations that the Power switch can initiate are: 

• Power On 

• Power Off 

• Suspend 

 
Power On 
To power on the BL ident-Handheld: 

5. Press and hold the ON/OFF switch for one second. 

6. The unit should turn on and begin displaying the boot-up process. For example: 

***** JETT.ce 
***** 
Loader Ver x.x.x 
Booting from System Socket 
Loading CE image... 
################# 

Where x.x.x is the version number 

7. After approximately 20-25 seconds, the Windows CE .NET desktop should appear. 

However, because there is no outward indication (such as a flashing LED) that the BL ident-
Handheld is powered off or in Suspend mode, the BL ident-Handheldmay resume an active 
application if it is indeed in a suspended state. 

If the unit does not power up or you cannot select any items from the desktop, refer to the 
“Troubleshooting” chapter for help. 
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Power Off 
To turn off the BL ident-Handheld, press and hold the ON/Off switch for approximately eight seconds. 
This action will also terminate running applications and cease serial port operations). 

Suspend Mode 
Suspend mode allows you to suspend, but not terminate active applications. In this mode, the display 
will turn off and the BL ident-Handheld will cease serial port operations. For battery-powered units, 
use of Suspend mode also conserves battery power. 

To place the unit in Suspend mode, press and release the ON/Off switch. 

To take the BL ident-Handheldout of Suspend mode, either touch the screen or press and release any key. 
The display will turn on and the BL ident-Handheld will resume running any suspended application, but 
you must restart any serial port operations. 

If you attempt to resume immediately after suspending the BL ident-Handheld or vice versa, the unit 
will automatically delay three seconds before resuming or suspending. 

Power Management  
Battery-powered units can utilize a rechargeable Nickel Metal Hydride (NiMH) battery pack that has an 
average operating time between ten and twelve hours on a full charge with power management and 
approximately eight hours without power management. As with all battery-powered devices, the 
operating time is completely dependent on the environment, device usage and the number and type of 
power-drawing peripherals attached. The battery discharge rate in a full “Power Off” state is only slightly 
higher to the self-discharge rate of the battery itself. 

Note: Allowing the batteries to remain in a low or very low condition will cause the unit to enter Suspend 
mode. In either case, you should save your work and recharge the unit as soon as possible 

To lengthen the time between charges, you can perform the following actions: 

• Use external power for PC Card operations whenever possible — some PC Cards as well as 
extended communication via the serial port, may require large amounts of power to operate, 
and can quickly drain the batteries. 

Limit the use of backlight—minimize backlight use when you are operating on battery power. 
You can adjust the backlight timeout level through the Display Settings in the Control Panel or 
on some units by using the keypad. 

 Shorten Auto-suspend time—the BL ident-Handheld is automatically set to suspend 
operation to conserve battery power when you have not used the keyboard or the stylus 
after three minutes. You can increase the Auto-suspend time by changing the Power settings 
in the Control Panel. 
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Replacing Batteries/Battery Pack 
CAUTION! There is a risk of explosion if you replace the NiMH battery with an incorrect type. Only use the 
NiMH battery supplied with your unit or a replacement NiMH battery supplied, recommended, or 
approved by TURCK, Inc. 

To replace the rechargeable battery pack or change AA batteries: 

1. Turn the power off. With the unit face down, pull the battery cover retaining clip up from its 
recessed slot and turn the clip in a counter clockwise motion (see Figure 3-6). 

2. Lift the cover up and remove the batteries/battery pack. 

3. If the unit contains a NIMH battery pack, use the tab to lift up on the battery pack and then 
out. 

4. Close the battery cover and turn the battery cover retaining clip clockwise to lock the cover. 

Figure 3-6: Changing Batteries 
B a t t e r y  P a c k  C o v e r  ( o p e n e d )  
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Data Entry 
Keypads  

45-Key Keypads 
In order to provide the functionality of a full-sized keyboard with only 45 keys, the BL ident-Handheld 
keypad must depart from PC-style key assignment conventions by making use of modifier keys. Units 
configured with the standard 45-key keypad typically utilize five LED indicators (located above the 
ON/OFF switch) to indicate the active state of keypad modifier keys. Units with 45-key keypads also 
have keypad functions to adjust the contrast and backlight. 

30-Key Keypad 
Units with a 30-key keypad provide a full complement of alphabetical characters. Users can access 
numeric characters, punctuation characters, navigation keys and backlight control via the SHIFT key. 

15-Key Keypad 
Typically, units shipped with a 15-key keypad have custom keyboard layouts geared toward specific 
applications that must be loaded onto the unit. To provide you a method of navigating and using 
Windows CE .NET until you configure and map your keypad in the context of your application using 
JETTkbtool. TURCK provides a template that shows the default functions (see figure below). 

Figure 3-7: Standard Keypad Layouts 

Modifier Keys 
The following modifier keys (located on the bottom of a standard keypad) enable you to access the 
various functions that can appear on a key. Figure 3-8 provides an example. 
Figure 3-8: 45-Keypad Multifunctional Key 
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Modifier keys take effect when first pressed and typically remain in effect until you press another key, 
unless its another Modifier key (see Table 3-2). Optionally equipped units can use LEDs to indicate the 
selection of a Modifier key. 

• CTRL and ALT Keys —operate in the same manner as on conventional PCs, except that by 
default they have a one-time locking action to facilitate one-handed operation. 

• SHIFT Key—unlike conventional PC keyboards, the SHIFT key enables you to access symbols, 
punctuation marks and navigation arrows rather than shift alphabetic keys to uppercase. 

On standard BL ident-Handheld keypads, the functions and characters accessed via the SHIFT 
key appear in the upper left of a key (shaded in gray in Figure 3-8). 

By default, the SHIFT key has a one-time action. However, you can press the Shift key twice and 
lock the keypad into Shift mode, wear each subsequent key press will only access characters that 
appear in the upper left of a key. Pressing the Shift key a third time will release Shift mode. 

• 2ND Key— shifts the numeric keys to corresponding function keys (1 = F1, 2 =F2, etc.) that are 
found on conventional PC keyboards. 

It also shifts other keys for punctuation, non-printing characters (such as Delete and TAB), and PC 
key definitions (such as PageUp, PageDown, Home, Insert and Caps Lock). 

On the standard BL ident-Handheld 45-key keypad, the functions and characters accessed via the 
2nd key appear at the bottom of a key, (shaded in blue in Figure 3-8). 

Like the Shift key, the 2ND key has a default one-time action and a locking mode (i.e., pressing the 
2ND key twice will lock the keypad into 2ND mode). 

.Table 3-2: Modifier Key Actions 

Key Presses Result 
A Lowercase “a” 
Shift & A Move cursor left one position 
2ND & A Delete Character 
2ND & Caps Lock Uppercase “A”  

Key Repeat 
By default, the BL ident-Handheld does not automatically repeat a key stroke when you hold down a 
key. However, you can enable the key repeat function by configuring the Keyboard setting in the 
Control Panel. 

CE Keyboard 
In addition to entering data through the keypad, you can also enter data by using the CE Keyboard. 
This utility displays a keyboard on the screen to allow data entry via the Command Line or into 
applications where “text accessibility” control has focus (i.e., text or combo box). 
To use the CE Keyboard, select Programs > CeKeys from the Start menu. 

To minimize the keyboard, click the keyboard icon that appears in the system tray 

Figure 3-9: CE Keyboard 
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Using the RFID Module 
The RFID module can read and write (up to 16k bits) most industry standard 13.56MHz RFID tags and 
smart labels including for 13.56MHz RFID tag types including ISO-15693, Tag-It by Texas Instruments, I 
Code by Philips, GemWave by TagSys, and PicoTag from Inside Contactless (see Table 1-1 for specifics). 

.The RFID module is totally application dependent and derives power from the COM2 port. The RFID 
module has a flip-out antenna that provides a read range of approximately 3.5 inches (90mm) with a 
credit card size tag at 90 degrees (see illustration below). For RFID module application integration 
information, contact TURCK. 

Figure 3-10: RFID Read Range 
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The Windows CE .NET Desktop 
This section provides a brief overview of the functions that appear on the BL ident-Handheld desktop. 
For information on how to change desktop settings, refer to Windows CE .NET help (Start > Help). 
Figure 3-11: Windows CE .NET Desktop 

 

Desktop Functions 
You can access the following applications, functions and data entry utilities from the BL ident-
Handhelddesktop: 
Table 3-3: Desktop Functions 

Icon Function Description 

 
 

Recycle Bin   Use the Recycle Bin to restore deleted files or empty the bin to 
  create more disk space. 

 
 

My Computer Use My Computer to navigate and view the folders and files 
stored on the BL ident-Handheld. 

 
 

Inbox Use the Inbox to send and receive e-mail by connecting to a 
POP3 or IMAP4 server. 

 
 

My Documents The default storage location for documents, graphics, and other 
files. 

 
 

Microsoft WordPad Use WordPad to create or edit text files that contain formatting 
or graphics. 

 
 

Internet Explorer Use Pocket Internet Explorer to view Web pages. You will need 
a modem or Ethernet card to connect to an Internet service 
provider (ISP) or network. 

 
 

PC Link Use PC Link to make an ActiveSync, Bluetooth or other type of 
connection to another device  

The Taskbar 
The taskbar at the bottom of the BL ident-Handheld desktop displays the Start button, buttons of 
currently running applications, the Status Area and the Show Desktop icon. 
Tap the Start button to display the Start menu (see below for details). For each open application, a 
button appears on the taskbar. Simply tap the button to activate the application. 

The status area appears on the right and by default displays small icons for the input panel, current 
time, power status and network connections. Tap an icon to activate the related program. 

Tapping the Show Desktop icon minimizes active applications and redisplays the desktop. Tapping the 
Keyboard icon displays the Input Panel menu for data entry. 

 
Figure 3-12: Windows CE .NET Desktop Taskbar 
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Power Status Icons 
The BL ident-Handheld will display power status icons (Table 3-4) in the taskbar status area (Figure 3-
12) to indicate power use, charging status and low battery conditions. 

Table 3-4: Power Status Icons 

Icon Description 

 External AC power supply connected 

 
Batteries are charging 

 
Batteries are low —approximately 60 minutes or less of use remaining (the 
CHARGE/LOW BAT LED will blink red once per second) 

 
 

Batteries are very low—approximately 10 minutes or less of use remaining (the 
CHARGE/LOW BAT LED will turn solid red)  

The Star t  Menu 
When you tap Start, the Start menu appears. 

Figure 3-13: Start Menu 

 
By tapping one of the menu’s icons (and not the name), you can: 

• Open programs that do not appear on the desktop 

• View a list of web sites added to your Favorites List 

• View recently accessed documents and images 

• Access the Control Panel, establish connections, or configure the Taskbar and Start Menu 

• View Help 

• Start an application using the Run command 

• Place the unit in Suspend mode 

SystemCF Folder 
The only folder that provides non-volatile (permanent) storage is the SystemCF folder. Information store 
in other folder will be lost when you remove power from the BL ident-Handheld. You can however, have 
the BL ident-Handheld automatically copy files from the SystemCF to other folders when booting up. See 
Launching Files at Startup for more information. 
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Chapter 4: Configuration 

The Control Panel 
The table below lists the available control panel functions on the BL ident-Handheld. 

Table 4-1: Control Panel Functions 

Icon Function Description 

 
 

Aux Switch For units with a second COM that supplies 5VDC output, use 
this function to set the default power state (On or Off), and test 
the connected devices. 

 
 

Backlight Use this function to adjust the backlight setting for the following 
conditions: Line Active, Line Active Inactive, Battery Active and 
Battery Inactive. 

 
 

Battery Select Select one of the following options to calibrate the power status 
icons for proper use: NIMH, AC Line or Alkaline. 

 
 

Beep Select Use this function to change the frequency, volume and duration 
properties of the beep. 

 
 

Bluetooth Device 
Properties 

Use this function to scan for other Bluetooth devices and services 
in the area. For use by Bluetooth cards manufactured by 
companies other than Socket Communications, Inc. Socket cards 
use a different control. See Using Bluetooth for more 
information. 

 
 

Certificates Use this function to import, view or remove certificates, which 
protect your personal information on the Internet, and protect 
your computer from unsafe software. 

 
 

CPU Speed For units with 400 MHz processors, use this function to 
determine the CPU speed (200 or 400 MHz) and mode (Turbo 
and Non-Turbo) during runtime and cold boot-up. 
Turbo Mode allows you to clock the processor core at a higher 
frequency during peak processing requirements. 

 
 

Date/Time Use this function to adjust the date, time and time zone. 

 
 

Dialing Use this function to adjust the dialing location settings and 
dialing patterns when using a modem. 

 
Display Use this function to adjust the backlight timeout, change the 

background image or change the desktop color scheme. 

 
 

Display Rotation Use this function to rotate the screen 180 degrees (upside down). 

 
 

Hot Keys Use this function to assign functionality to the unit’s eight 
programmable keys (requires Keyboard Mapping). 
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Icon Function Description 

 
 

  Input Panel Use this function to adjust the settings for the input panel. 

 
 

  Internet Options Use this function to set up connections, security settings and 
internet related functions. 

 
 

Keyboard Use this function to change the repeat delay and repeat rate. 

 
 

Network and 
Dial-up Connections 

Use this function to change network adapter settings and/or set 
up identification for remote networks. 

 
 

Owner Use this function to enter the owner name, address, phone 
numbers and network ID. 

 
 

Password Use this function to enable password protection and set a 
password. 

 
 

PC Connection Use this function to enable direct connection to a desktop 
computer 

 
 

Power Use this function to: 
~ Check battery power 
~ Set device to turn off when idle 
~ Set up power schemes 
~ Check the power levels of your system devices 

 
 

Regional Settings Use this function to change the appearance of region specific 
information, such as date, time and currency. 

 
 

Remove Programs This function enables you to remove programs installed in RAM. 

 
 

Storage Manager 
This function enables you to perform the following tasks: 

• View partition information 
• Format a partition 
• Create or delete a partition 
• Mount or dismount a partition 
• Scan and repair a partition. 
• Defragment a partition 

 
 

Stylus Use this function to recalibrate the touch screen and adjust the 
stylus double-tap rate. 

 
 

System Use this function to view system information, change the RAM 
(Program/Storage memory) division, change the device name 
and change the device description.. 

 
 

VComAdj Use this function to minimize screen flicker and adjust contrast. 
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Changing System Sett ings 
Any time you make changes through the Control Panel (such changing the time zone), you must also 
update the persistent registry to store the changes in internal compact flash memory to make the 
changes permanent. 

For example, to change the time zone and save the changes to the registry: 

1. Select Start > Settings > Control Panel. 

 
2. On the Control Panel, double-tap Date/Time. The Date/ Time Properties dialog box appears. 

You can now set the date, time and time zone. 

 
3. To adjust the Current Time, use the scroll bars to increase or decrease the value, or tap hours, 

minutes, seconds or AM/PM indicator to set the values individually. 

4. To select the Time Zone, use the corresponding list. 

5. To adjust the Date, either: 

� Tap the arrows on the calendar to select the previous/next month 

� Double-tap the month or year to select it from a list 

� Tap a day to select it 

6. To adjust the clock automatically for daylight savings, check the corresponding box. 

7. Tap Apply to have your setting take effect. 

8. Tap OK to close the Date/Time Properties dialog box and return to the Control Panel. 

9. Tap OK to exit the Control Panel. 

10. From the Start menu, select Programs and tap Save Registry. 
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Taskbar and Start Menu Settings 
To change the Taskbar and Start Menu settings: 

1. Select Start > Settings> Taskbar & Start Menu. The Taskbar and Start Menu Properties dialog 
box opens: 

2. Select the General tab: 

 
3. Check Always on Top to ensure that the taskbar is always visible, even when a program 

appears in a full window (maximized). 

4. Check Auto hide to display the taskbar just when you point to the taskbar area. 

5. Check Show Clock to display the time of day in the taskbar. 

6. Select the Advanced tab: 

 
7. Tap the Clear button to remove the contents of the documents menu. 

8. Check the Expand Control Panel box to display the contents of the Control Panel as items on 
the Settings | Control Panel menu. 

9. Tap OK to save the settings and exit the menu. 

10. From the Start menu, select Programs and tap Save Registry. 
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Using the Compact Flash Slot 
BL ident-Handheld’s equipped with a standard Compact Flash Slot access cover will allow you to access 
the slot to insert and remove Compact Flash and device cards. 

If you intend to use a device card, it may also be necessary to install a driver. If so, make sure the card is 
Windows CE .net compatible and you have the necessary drivers. If you are not sure, check with the card 
manufacturer before attempting to install the card. 

To transfer files using the compact flash slot: 

1. With the front of the display facing you, push the compact flash slot cover (located on top of the 
unit) to the left. 

3. Insert the compact flash/device card into the slot with the front of the display facing you and the 
top of the card pointed to the slot until it clicks and the release lever moves upward. 

 
4. Close the cover. 

5. When inserting memory cards, a “UserCF” folder will appear when you open My Computer. 
You can then copy and paste the contents of UserCF to the other folders on the BL ident-
Handheld. 

When inserting device cards, the BL ident-Handheld will attempt to recognize the device. If it 
finds a driver for the device, the BL ident-Handheld will display a dialog box for that device. 
For example: 

 
If the BL ident-Handheld cannot find a driver for the device, it will display the following dialog 

box: 

 
6. If the correct card type appears, you can enter the appropriate information in the dialog box as 

required and then tap OK to complete the installation. 
7. To remove a card from a slot, simply push the card release lever down and remove the card. 
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Network Connections 
You can connect directly to a network using one of the following card types to access e-mail, access files 
available on the network server, and browse the Internet: 

• Wired Ethernet CF Card 

• WLAN 802.11b (Integrated or CF Card) 

• Bluetooth Class 1 (Integrated or CF Card) 

• Bluetooth Class 2 CF (Integrated or Card) 

Creating a Wired Ethernet Network Connection 
To create a Wired Ethernet connection: 

1. Insert the Ethernet card into the BL ident-Handheld and connect the cable to the network. 

2. Select Start > Settings > Control Panel. Double-tap Network and Dial-Up Connections. 

3. Double-tap the connection icon for the adapter. For example, if you have a NE2001 Ethernet 
adapter, double-click the NE2001 connection icon. 

4. In the Ethernet Driver Settings dialog box, select Obtain an IP address via DHCP and tap OK. 

 
5. If prompted, enter the User Name, Password, and Domain name you use to log on to your 

network. 

6. From the Start menu, select Programs and tap Save Registry. 

Creating Network Connection using a WLAN 802.11 b Card 
To create a network connection using a WLAN 802.11b card: 

1. Insert the WLAN 802.11b card into the BL ident-Handheld. 

2. Select Start > Settings > Control Panel. Double-tap Network and Dial-Up Connections. 

3. Double-tap the connection icon for the adapter. For example, if you have a NE2001 Ethernet 
adapter, double-click the NE2001 connection icon. 

4. In the Ethernet Driver Settings dialog box, select Obtain an IP address via DHCP and tap OK. 

5. If prompted, enter the User Name, Password, and Domain name you use to log on to your 
network. 

6. From the Start menu, select Programs and tap Save Registry. 
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Setting Up Identification for Remote Networks 
To set up identification for remote networks: 

1. Select Start > Settings > Control Panel. 

2. Double-tap Owner. 

3. In the Network ID tab, enter the user name, password, and domain name you use to log on to 
the remote network. 

4. From the Start menu, select Programs and tap Save Registry. 

Connecting to a Mail Server 
You can send and receive e-mail by connecting to a POP3 or IMAP4 server. Inbox contains an e-mail 
service for each method you use. For either service, you must establish a connection to your Internet 
service provider (ISP) or to the appropriate mail server in your local area network. In addition to 
creating this connection, you must also create the e-mail service. 

Prior to setting up a service, you should obtain the following information from your ISP or network 
administrator: POP3 or IMAP4 server name, SMTP host name, user name, password and domain name 
(for network connections only). 

Notes: Windows CE .Net does not support other mail protocols such as AOL or services that use special 
authentication, such as MSN. However, you can gain access to the Internet through these services. If you use 
the same service to connect to different mailboxes, set up and name a different service for each 
connection. For additional information about the inbox, refer to Windows CE .NET online help. 

To connect to your POP3 or IMAP4 mail server: 

1. Select Start > Programs > Inbox > Services > Options. The Options dialog box opens. 

 
2. Select the Services tab and tap Add. The Service Name dialog box opens. 

 
3. From the Service type list, select POP3 Mail or IMAP4 Mail. 
4. Enter a unique name for the service (you cannot change this name once entered). 

5. Tap OK. The Mail Service Setup wizard appears. 
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6. In the Required panel: 

� Select the name of the connection you created to connect to the mail server. If you are 
receiving e-mail through a network (Ethernet) connection, select Network Connection. 

If you want Inbox to use your current connection, select (none). 

If you have not created a connection, select Create new connection, double-tap the Make 
New Connection icon, and follow the instructions in the wizard. When finished, select 
Inbox in the Taskbar and continue setting up Inbox. 

� Enter the POP3 Host or Server (IMAP4) name of the mail server you use to receive and 
send messages. 

� Enter the User ID (user name or mailbox ID) assigned to you. 

� Enter the password you will use to access this mail account. If you do not want a prompt 
to enter the password each time you connect, select Save password. 

7. In the Optional panel: 

� If connecting to a network that uses Windows NT domain security, enter the Windows 
NT domain name. 

� If your mail service uses a separate server for SMTP, enter the SMTP Host name. For 
POP3 Mail service with an ISP, the ISP must use an SMTP mail gateway. 

� Enter your return e-mail address. 

8. Tap Next. The General Preferences dialog box opens. 

 
9. Choose any of the settings, all of which are optional, then click Next. The Inbox Preferences 

dialog box opens. 

 
10. Choose any of the settings as needed, then click Finish. The Mail Service Setup wizard closes 

and the Options dialog box reappears. 

Note: Receiving entire messages consumes storage memory. 

11. Close the Options dialog box to return to the Inbox. 

12. From the Start menu, select Programs and tap Save Registry. 
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ActiveSyn c 
ActiveSync is a desktop utility program (available as a free download from Microsoft) that allows you to 
synchronize certain types of information between a PC and the BL ident-Handheld. You can also use 
ActiveSync to transfer files and install programs on the BL ident-Handheld. 

When connecting the BL ident-Handheld to the PC via ActiveSync, you can opt to create a partnership 
and subsequently have the PC automatically recognize the BL ident-Handheld and synchronize 
information. You can also create a temporary Guest partnership to copy files and install programs. 

The following procedures describe how to make an ActiveSync connection using a serial interface cable. For 
information on how to make an ActiveSync connection using Bluetooth or Wi-Fi, refer to the appropriate 
manual. 

Init ial Communication 
To setup initial communication between the PC and the BL ident-Handheld: 

1. Connect an interface cable to an available COM port on the PC and the BL ident-Handheld’s 
RS-232 port. 

2. On the PC, start ActiveSync. 

 
3. On the ActiveSync menu bar, select Connection Settings from the File menu. The Connection 

Settings dialog box opens. 

 
4. If not selected, check the Allow serial cable or infrared connection to this COM port box, and 

assign the number of the available COM port (typically COM1). 

5. Click OK to exit. 
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6. On the ActiveSync menu bar, select Get Connected from the File menu. ActiveSync will then 
start the Get Connected wizard. 

 
7. Click Next. ActiveSync will start attempting to establish a connection (this process will take 

several seconds). 

 

On the BL ident-Handheld, tap PC Link
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9. If ActiveSync successfully establishes communications, the ActiveSync dialog will briefly 
reappear on the PC and start the New Partnership dialog wizard. 

 
10. Select your Partnership option as needed and complete the wizard. The ActiveSync dialog box 

will reappear and display a status of “Connected.” For example: 

 
11. On the BL ident-Handheld, an icon indicating a ActiveSync connection will appear in the system   
        tray. 
 

 
12. To terminate the ActiveSync connection, double-tap the connection icon to display the Connect 

To dialog box and tap Disconnect.   
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Subsequent Communication 
After you install ActiveSync and establish the initial communication between the PC and the BL 
ident-Handheld, use the following procedure to set up subsequent sessions: 

1. If not already attached, connect an interface cable to an available COM port on the PC and the 
RS-232 port on the BL ident-Handheld. 

2. On the BL ident-Handheld desktop, tap PC Link to attempt to reestablish communications 

3. When communications is successfully reestablished, the New Partnership wizard appears. 

 
4. Select No on the PC and then click Next. A status of “Connected” should appear in the 

ActiveSync window. 

 

Persistent Registry 
Saving Changes to the Registry 
The BL ident-Handheld internal memory consists of DRAM and Flash. Typically, any changes made to 
the BL ident-Handheld including file creation are temporarily stored in the unit’s DRAM. You must then 
copy the files from DRAM to internal flash memory or a removable compact flash card to store the 
information permanently. 

Consequently, if you do not store the information to flash memory and the unit loses power, all 
information stored in DRAM will be lost. However, whenever you make changes that affect the 
registry, such and changing settings in the Control Panel or installing software, you can permanently 
store registry changes without writing to flash memory by using the Persistent Registry. 

Note: The BL ident-Handheld will store registry information every time you perform a suspend operation. 
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To store registry information on the BL ident-Handheldpermanently: 

1. From the Start menu, select Programs and tap SaveReg. 

 
2. The BL ident-Handheld will begin saving the registry. 

 
After you successfully save the registry, a message box will appear: 

 
3. Tap OK to close the message box. 

Resetting the Registry 
To reset the Windows CE .NET registry back to the factory default settings: 

1. Turn off the BL ident-Handheld. 

2. While holding the key in Column 1, Row 1 (upper leftmost) and the key in Column 1, Row 3, 
turn on the BL ident-Handheld. For example: 

 
3. If you are successful, the screen will display version information, followed by “Invalidating 

Persistent Registry,” before it completes the boot up process. For example: 

***** JETT.ce 
***** 
Loader Ver x.x.x 
Invalidating Persistent 
Registry 
Booting from System Socket 
Loading CE image... 
################# 

Where x.x.x is the version number 
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Chapter 5: Application Development 

Application Types 
Before writing applications for Windows CE .NET 4.2 and the BL ident-Handheld, you will need to 
determine if your applications will consist of managed code and/or native code. 

• Managed code makes use of run-time environment application programming interfaces (APIs), 
provides integrated security and memory management and is portable across software platforms 
and processors. Code written in Microsoft Studio .NET 2003 is managed code. 

• Native code uses a specific set of software platform APIs and microprocessor and as a result, 
the compiled code will only run on that specific software platform and processor. Typically, 
native code offers the highest performance with the smallest footprint, but it also requires 
developers to write their own security and memory management code. Code written in 
eMbedded Visual C++ is native code. 

The type of application being created will dictate the choice between native and Microsoft .NET— 
connected code. When a consistent programming model and time-to-market are the primary 
considerations, use Visual Studio .NET and the .NET Compact Framework. When performance, the 
smallest working set, and low-level control are a top priority, use eMbedded Visual C++. 

Development Tools 
To write Windows CE .NET 4.2 applications for the BL ident-Handheld, you will need to obtain one 
the following Microsoft products: 

• Visual Studio .NET 2003—this development tool installed with the .NET Compact Framework 
allows you to build embedded managed applications for the BL ident-Handheld using C# .NET 
and Visual Basic .NET. 

• eMbedded Visual C++ 4.0—a standalone integrated development environment (IDE) 
designed for developing native C++ applications for BL ident-Handheld. 

If you are using Visual Studio .NET 2003, you will also need to download and install Windows CE 
Utilities for Visual Studio .NET 2003, which enables you to connect to the BL ident-Handheld. 
If you are using eMbedded Visual C++ 4.0, you will also need to install the TURCK’ JETT•ce 
SDK. It includes APIs for application development, user interface design elements, and 
documentation. 

Other development tools you need include: 

• ActiveSync —this Microsoft utility allow you to transfer files between the BL ident-
Handheld and your development system. 

• JETTkbtool.exe —included with the JETT•ce SDK, this MS-DOS application enables you to 
remap the BL ident-Handheld keyboard. 

Note: As of this writing, eMbedded Visual C++ 4.0, ActiveSync 3.7 and Windows CE Utilities for Visual Studio .NET 
2003 are available as downloads on Microsoft’s website. After installing any Microsoft product, you should 
check their website for newer versions or service packs. 
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Using Visual Studio .NET 
Visual Studio .NET 2003 provides a robust development environment for creating applications that 
target the .NET Compact Framework. Included with Visual Studio .NET is a set of pre-built device 
profiles. A device profile contains information necessary to build applications that target specific 
devices, such as the BL ident-Handheld. 

System Requirements 
To use Visual Studio .NET 2003, your development system must meet the following minimum 
requirements: 

Processor 450 MHz Pentium II, 
Operating Systems   Windows Server 2003, Windows 2000 Server or Professional (SP3 or later) or 

  Windows XP Prof essional or Home Edition¹ 
RAM Memory Windows Server 2003 & Windows XP Professional : 160 MB 

Windows 2000 Professional & Windows XP Home Edition: 96 MB of RAM 
Windows 2000 Server: 192 MB of RAM 

Disk Space System Drive: 900 MB, Installation Drive: 3.3 GB 
Optional MSDN Library documentation: 1.9 GB 

Drive CD-ROM or DVD-ROM drive 

Display Super VGA (1024 x 768) or higher-resolution display with 256 colors 

Mouse Mouse or compatible pointing device  
1. Visual Studio .NET 2003 does not support creating ASP.NET Web applications or ASP.NET XML Web services when using 

Windows XP Home Edition. 

The .NET Compact Framework 
The .NET Compact Framework is a subset of the .NET Framework designed specifically for small, 
resource-constrained devices, such as the BL ident-Handheld. Applications that run on top of the .NET 
Compact Framework are able to use a range of run-time services — including a common language run-
time, memory management, and a rich set of base classes that handle security, data access, and XML 
Web services. 

Supported Lan guages 
The .NET Compact Framework currently supports two development languages, C# .NET and Visual 
Basic .NET. 

You should also be aware that there is another language limitation under the .NET Compact 
Framework. Under the .NET Framework, you can use mixed-language components within a single 
project. In comparison, .NET Compact Framework projects are restricted to a single language, either C# 
.NET or Visual Basic .NET. The workaround to this single-language project limitation imposed by .NET 
Compact Framework is to create additional projects using the Class template. Add your alternate 
language code to the template, and then simply add references to these classes in your application 
project. 
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.NET Compact Framework Limit ations: 
You use the same Visual Studio .NET environment that you use when developing desktop applications, but 
in order to fit the .NET Framework into the operating constraints of Windows CE, the following 
limitations apply: 

• Method Overloads —overloading a method provides alternative ways to call that method, but 
it also increases the size of the Framework. As a result, the .NET Compact Framework trimmed 
the overloads from almost all methods. Consequently, there is a good chance that a particular 
method overload you used with a desktop application will not be available when developing 
.NET Compact Framework-based applications. 

• Missing Controls —a number of .NET Framework controls are not part of the .NET Compact 
Framework. The absence of most of these controls (such as printing) is insignificant to mobile 
developers. You can replace many of the missing dialogs with your own dialogs or by 
accessing system dialogs directly using the Windows CE API. 

• XML Functionality—as much as the .NET Compact Framework offers in the way of XML, an 
equal amount of functionality was trimmed. A key missing XML-related component is the 
System.Xml.XPath namespace. In its absence, you can use a combination of recursive and 
iterative searches against the Document Object Model (DOM). Another missing key XML 
component is Extensible Style sheet Language Transformation (XSLT), which convert an XML 
document into different formats. In addition, the .NET Compact Framework does not currently 
provide support for developing device-based XML Web services. 

• Database Support—the .NET Compact Framework offers a robust set of data-related tools. 
SQL Server CE provides local database support, while on the server side, the .NET Compact 
Framework provides support for SQL Server. 

• Binary Serialization—due to size and performance considerations both the BinaryFormatter 
and SoapFormatter classes are not part from the .NET Compact Framework. 

• Access to the Windows Registry—the .NET Framework uses the Microsoft.Win32.Registry 
namespace to work with the Windows registry from an application. Because it relates to Win32 
and not Windows CE, this namespace was not included in the .NET Compact Framework. 
However, you can access the Windows CE registry by invoking the relevant Windows APIs. 

• Leveraging COM Components—incorporating COM objects into a .NET Compact Framework-
based application is a two-step process. First, you must write an unmanaged DLL wrapper using 
eMbedded Visual C++ that exposes the COM object. Then, you must use PInvoke to access your 
DLL wrapper. 

• Security—the .NET Compact Framework does not secure access to unmanaged code. Any 
application can call any system or non-system API. There is currently no role-based security 
with the .NET Compact Framework. The principal object has no understanding of known 
identity or known role. 

• XML Web Services—the most notable exclusion from the .NET Compact Framework XML 
Web service capabilities is the ability to use cookies. Cookies are widely used to maintain state on 
the server between calls from a client. While the use of cookies in Web services is not as 
prevalent as their use on Web sites, they are still in use. The .NET Compact Framework offers 
limited cryptographic abilities with respect to Web services. 

• Printing—the .NET Compact Framework provides no support for printing. There is no easy 
way to interact with network printers. The workaround for accessing network printers is to 
build a server-based application, which accepts and prints jobs submitted by your application. 

• GDI+ —Windows CE .NET does not natively support GDI+, and therefore is not part of the 
.NET Compact Framework. 

• Remoting—the initial release of the .NET Compact Framework does not support remoting. If 
you need to communicate with .NET components situated on a remote machine, you should 
implement an XML Wed service façade for the component and access it that way. 



 

 5 –  4        Hans Turck GmbH & Co.KG • Witzlebenstraße 7 • 45472 Mülheim/Ruhr • Germany • Tel. +49 (0)208 4952-0 • www.turck.com

Getting Started with Visual Studio .NET 
The section will help you become familiar BL ident-Handheldapplication development using Visual 
Studio .NET 2003. Procedures in this section include creating a “Hello World” application, deploying 
the application and creating a redistributable CAB file. For more information about using Visual Studio 
.NET, refer to its online help. 

Preliminary Setup 
Before using Visual Studio .NET 2003 to create a “Hello World” project for the BL ident-Handheld, you 
must assign a device CPU. 

To assign a device CPU: 

1. Using ActiveSync, establish communication with the BL ident-Handheld. 

2. Start Visual Studio .NET 2003. 

3. On the Tools menu, click Select Windows CE Device CPU. The Select Windows CE Device 
CPU dialog box opens. 

 
4. Select ARMV4 as the device architecture from the drop-down box and click Configure. 

5. Click Close and exit Visual Studio .NET. 

Creating a “Hello World” Application 
After restarting Visual Studio .NET, you will be able to create, debug and deploy managed code 
applications for the BL ident-Handheld. 

To create a “Hello World” project in Visual Basic .NET: 

1. Restart Visual Studio .NET 2003. 
2. From the File menu, select New, and then click Project. 

 
3. Click New Project. The New Project Dialog box opens. 
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4. Under Project Types, select Visual Basic Projects. 

5. Under Templates, select Smart Device Application. 

6. Type the Name (such as HelloWorld) and then select the Location of the project (such as 
C:\Visual Studio Projects). 

7. Click OK. The Smart Device Application Wizard opens. 

 
8. Select Windows CE as the target platform, Windows Application as the project type and then 

click OK. You are now ready to begin application development. 
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To ensure that the form fits on the BL ident-Handheld, change the Size in the Form1 
properties to 200,100. Also, change the Text to “Hello World.” 
Using the Toolbox (selected from the View menu), place a button on the form and then double-
click the button to open the code window. 

Enter the following line of code in the button's Click event handler: 

MsgBox("Hello World")  

 
Building and Deploying the Application 
Before building your application, you must select a configuration type (Debug or Release). A Debug 
configuration will compile with full symbolic debug information, but no optimization. A Release 
configuration with compile with full optimization, but contain no symbolic debug information. 
To build and deploy the application to the BL ident-Handheld: 

1. On the Standard toolbar, choose Release from the Solution Configurations list box. 

2. From the Build menu, select Build HelloWorld. Visual Studio .NET will then build the 
HelloWorld application. Review the Output panel to make sure the build succeeded without 
any errors. You are now ready for deployment. 

3. From the Build menu, select Deploy HelloWorld. The HelloWorld dialog box opens. 

 

4. Choose Windows CE .NET Device as the target smart device and click Deploy to start the 
deployment process. Visual Studio .NET will then communicate with the BL ident-Handheld, 
create a Hello World folder under "\Program Files" and install the HelloWorld application 
there. 

Note: To store the files permanently, you can either copy the files to internal compact flash (the 
SystemCF folder) to a memory card. 

5. To run the HelloWorld application on the BL ident-Handheld, select Programs from the Start 
menu and tap HelloWorld, then click the button on the form to display “Hello Word.” 
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Creating a Redistributable CAB File 
To create a redistributable CAB file for the BL ident-Handheld: 

1. From the Project menu, select Properties. In the Common Properties node, select Build. 

2. Use the Browse button to locate an icon (.ICO file). By default, icon files are installed in the 
"C:\Program Files\Microsoft Visual Studio.NET 2003\Common7\ Graphics\icons" folder. 

In this example, choose exclem.ico from the "Misc" subdirectory and click OK. Visual Studio 
.NET will then add the icon to the project files and set the icon file's Build Action to Content. 

 
3. From the Build menu, choose Build Cab File. This action creates CAB files in your project’s 

“\cab\Release” folder for all supported hardware platforms. 

 
4. Using ActiveSync, copy the HelloWorld_WCE4.ARMV4.CAB to the Temp folder on the 

BL ident-Handheld. Refer to the “Using ActiveSync” section for details. 

5. After you transfer the CAB file, simply tap it to perform the installation. 

By default, the CAB file installation program will automatically attempt to install the 
HelloWorld application and related files in a folder under "\Program Files," but this action will 
only store the files temporarily in the unit’s DRAM (i.e., if you turn the power off, the 
application files will be lost). To store the files permanently, you can either copy the files to 
internal compact flash (the SystemCF folder) to a memory card. 

 
6. To run the HelloWorld application on the BL ident-Handheld, select Programs from the Start 

menu and tap HelloWorld. 
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Using eMbedded Visual C++ 4.0 
eMbedded Visual C++ 4.0 is a standalone integrated development environment (IDE) designed for 
developing applications for BL ident-Handheld. It consists of an integrated set of windows, tools, 
menus, toolbars, directories, and other elements to help create, test, and debug a Windows CE 
application. 

As of this writing, eMbedded Visual C+ +4. 0, this program and its subsequent service patches are 
available for download on Microsoft’s website. 

Migrating Previous Versions of eMbedded Visual Tools 
Windows CE .NET 4.2 does not support the use of eMbedded Visual Tools 3.0. 

If you want to continue developing applications in Visual Basic, you will be able to use Visual Studio 
.NET, but you will not be able to directly migrate your existing applications to Visual Basic .NET. 

However, Visual Basic .NET does includes an Upgrade Wizard for migrating Visual Basic 6.0 
application and some portion of your eMbedded Visual Basic applications will be able to take 
advantage of this feature. You can find additional information on the MSDN Web site. 

Developers using eMbedded Visual C++ 3.0 can rebuild their application in eMbedded Visual C++ 4.0. 

System Requirements: 
To use eMbedded Visual C++ 4.0, your development system must meet the following minimum 
requirements: 

Processor 450 MHz Pentium II 
Operating Systems Windows 2000 Server 

Windows 2000 Professional (SP2 or later) 
Windows XP Prof essional 

Memory Windows 2000 Professional & Windows XP Professional: 96 MB RAM 
Windows 2000 Server: 192 MB RAM 

Disk Space 200 MB 

Drive CD-ROM 

Display VGA or higher-resolution monitor 

Mouse Mouse or compatible pointing device 
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Gett ing Started with eMbedded Visual C++ 4.0 
The section will help you become familiar with BL ident-Handheld application development using 
eMbedded Visual C++ 4.0. Procedures in this section include creating a “Hello World” application, 
deploying the application and creating a redistributable CAB file. For more information about using 
eMbedded Visual C++ 4.0, refer to its online help. 

Creating a “Hello World” Application 
To create a “Hello World” project: 

1. Using ActiveSync, establish communication with the BL ident-Handheld. 

2. Start eMbedded Visual C++ 4.0. 

3. From the File menu, select New. The New dialog box opens. 

 
4. In the New dialog box : 

~ Type in the Project Name and select a location. 

~ Under Projects, select WCE MFC AppWizard (exe). ~ 

Under CPUs, check Win32 (WCE ARMV4I). 

5. Click OK. The WCE MFC AppWizard (exe) dialog box opens. 

 
6. Click Dialog based and then click Finish. The New Project information dialog box opens. 
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7. Click OK to close. The Hello World workspace opens in the upper left pane. 

8. On the WCE Configuration toolbar, select JETT ce for the Active WCE Configuration, Win32 
(WCE ARMV4I) Debug for the Active Configuration and JETT ce Device as the device type. 

 
9. Add a button to the form: 

� In the HelloWorld workspace, click the Resources tab, expand the Dialog folder and then 
double-click IDD_HELLWORLD_DIALOG. The Hello World form opens in the adjoining 
pane. 

� From the Controls toolbar, drag a button onto the form. 

Note: If the Controls toolbar does not appear, you can activate it by right clicking the WCE 
Configuration toolbar 

� Right-click the button, select Properties. The Push Button Properties dialog box opens. 

� Change the caption to "Click Here!" and close the dialog box. 

 
10. Double-click the button. The Add Member Function dialog box opens. 
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11. Click OK to add the member function. HelloWorldDlg.cpp opens in a new window. 

 
12. Replace the text: 

// TODO: Add your control notification handler code here 

with the text: 
MessageBox (TEXT (" Your Message Here "), TEXT("Hello World"), MB_OK); 

Building and Deploying the Application 
To build and deploy the application to the BL ident-Handheld: 

1. From the Build Menu, select Build HelloWorld.exe. 

2. eMbedded Visual C++ 4.0 will then compile the program and attempt communication via 
ActiveSync with the BL ident-Handheld to download the application. After the transfer 
completes, you can then run the application on the BL ident-Handheld. 

 
3. On the BL ident-Handheld, navigate to the My Computer folder and double-tap the Hello 

World icon to run the application. 

 
4. Tap Click Here on the form to display “Hello Word.” Tap OK to close 

Storing the Application File: 
When eMbedded Visual C++ 4.0 deploys the HelloWorld application to the BL ident-Handheld, it also 
copies the Mfcce400d.dll file to the \Windows folder. Both files are temporarily stored in the unit’s 
DRAM. 

As long as the BL ident-Handheld remains powered on, you will be able to execute the HelloWorld 
application. If you turn the power off, the application files will be lost. 

To store the files permanently, you can either copy the files to internal compact flash (i.e., the SystemCF 
folder) or to a memory card. 
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Using the Windows CE .NET Remote Registry Editor 
By installing Microsoft eMbedded C++ 4.0, you can view or edit the Windows CE .NET Registry on the BL 
ident-Handheld. If you make any changes, you must invoke the Save Registry command to store the 
changes on the BL ident-Handheld. 
To use the Windows CE .NET Remote Registry Editor: 

1. If needed, establish an ActiveSync connection. 

2. From the Tools menu in eMbedded C++ 4.0, select Remote Tools and choose Registry Editor. 
The Select a Windows CE Device dialog box opens. 

 
3. Under JettCE, select JettCE Device and click OK. eMbedded C++ 4.0 will then attempt to copy 

the necessary files to the BL ident-Handheld to view the registry. 

 
4. After the file transfer successfully completes, the BL ident-Handheld registry should 

appear in Windows CE .NET Remote Registry Editor. 

 
5. To change a registry value, double-click the value that you want to change. To add or delete a 

registry value, use the Edit menu. 

Warning! Chan ging the registry values on the BL ident-Handheld can adversely effect its performance. 

6. After making your changes, perform a Save Registry on the BL ident-Handheld. 



 Hans Turck GmbH & Co.KG • Witzlebenstraße 7 • 45472 Mülheim/Ruhr • Germany • Tel. +49 (0)208 4952-0 • www.turck.com                5 – 13

Incorporating JETTce.dll Functionality 
JETTce.dll provides developers a method to quickly incorporate some or all of the following functions into 
their eMbedded C++ 4.0, Visual Basic .NET 2003 and Visual C# .NET 2003 application: 

• Screen Brightness —the following API calls enable you to increase or decrease the screen 
brightness in 20 percent increments: 

� IncBrightness 

� DecBrightness 

• Enable/Disable/Test Auxiliary Power—on units with a COM port that supplies power, the 
following API calls enable you to turn on, turn off and test the power for connected devices 
(such as RFID modules and bar code readers): 

� TurnAuxSwitchOff 

� TurnAuxSwitchOn 

� AuxSwitchIsOn 

• Soft Keyboard—the following API calls enable you to launch, display, hide, center and close 
the CeKeys program, a data entry program that replaces Microsoft’s’ Soft Input Panel (SIP) in OS 
versions 4.20.44 and above: 

� IsCeKeysRunning 

� IsCeKeysDisplayed 

� RunCeKeys 

� DisplayCeKeys 

� HideCeKeys 

� CenterCeKeys 

� ShutDownCeKeys 

• Enable/Disable LEDs—the following API calls enable you to turn on and turn off the 
BL ident-Handheld’s LEDs: 

� LedUpdate 

• Return MAC Address—the following API calls enable you to return the BL ident-Handheld’s 
unique MAC Address: 

� GetMacAddress 

• Suspend Function Control —the following API calls allow you to enable/disable the suspend 
function on the ON/OFF switch, and also return its status: 

� Suspend_Key_Lockout_Off 

� Suspend_Key_Lockout_On 

� Suspend_Key_Lockout 

� Suspend_Key_Lockout_State 

• Beep Driver Control—the following API calls enable you to control the frequency, volume 
and duration (in milliseconds) of the beep driver: 

� PlayTone 
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IncBrightness 
This function enables you to increase the screen brightness in 20 percent increments. 

Syntax 
void IncBrightness( 
void 
); 

Parameters 
None 

Return Values 
None 

DecBrightness 
This function enables you to decrease the screen brightness in 20 percent increments. 

Syntax 
void DecBrightness( 
void 
); 

Parameters 
None 

Return Values 
None 

TurnAuxSwitchOn 
On units with a COM port that supplies power, this function turns on the power for connected devices, 
such as RFID modules and bar code readers. 

Syntax 
void TurnAuxSwitchOn ( 
void 
); 

Parameters 
None 

Return Values 
None 
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TurnAuxSwitchOff 
On units with a COM port that supplies power, this function turns off the power for connected devices, 
such as RFID modules and bar code readers. 

Syntax 
void TurnAuxSwitchOff ( 
void 
); 

Parameters 
None 

Return Values 
None 

AuxSwitchIsOn 
On units with a COM port that supplies power, this function returns the status off the power for 
connected devices, such as RFID modules and bar code readers. 

Syntax 
bool AuxSwitchIsOn( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Indicates auxiliary power is on. 

FALSE Indicates auxiliary power is off.  

IsCeKeysRunning 
This function returns the status of the CeKeys data entry program. 

Syntax 
bool IsCeKeysRunning( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Indicates that CeKeys is active. 

FALSE Indicates that CeKeys is inactive. 
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IsCeKeysDisplayed 
This function returns the display status of the CeKeys data entry program. 

Syntax 
bool IsCeKeysDisplayed( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Indicates that CeKeys is running on the desktop. 

FALSE Indicates that CeKeys is minimized in the system tray or inactive.  

RunCeKeys 
This function invokes the CeKeys data entry program. 

Syntax 
bool RunCeKeys( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Indicates that CeKeys successfully executed. 

FALSE Indicates that CeKeys failed to execute.  

DisplayCeKeys 
This function displays the CeKeys data entry program (if running) on the desktop. 

Syntax 
bool DisplayCeKeys( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Displays CeKeys (if running) on the desktop. 

FALSE Indicates that it could not display CeKeys. 
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HideCeKeys 
This function minimizes the CeKeys data entry program (if running) in the system tray. 

Syntax 
bool HideCeKeys( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Minimizes CeKeys (if running) in the system tray. 

FALSE Indicates that it could not hide CeKeys.  

CenterCeKeys 
This function places the CeKeys data entry program (if running) in the center of the desktop. 

Syntax 
bool CenterCeKeys( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Places CeKeys (if running) in the center of the desktop. 

FALSE Indicates that it could not center CeKeys.  

ShutDownCeKeys 
This function terminates the CeKeys data entry program. 

Syntax 
bool ShutDownCeKeys ( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Indicates that it successfully closed CeKeys (if running). 

FALSE Indicates that it could not close CeKeys. 



 

 5 – 18        Hans Turck GmbH & Co.KG • Witzlebenstraße 7 • 45472 Mülheim/Ruhr • Germany • Tel. +49 (0)208 4952-0 • www.turck.com

LedUpdate 
This function enables you to turn on and turn off the LEDs on the BL ident-Handheld. 

Syntax 
bool LedUpdate( 
LEDVALUE led Val, 
bool bValue 
); 

Parameters 
Values Description 

 ledVal [In] Specifies of the following LEDs: 

 

~ LED_2ND 
~ LED_SHIFT 
~ LED_CTRL 
~ LED_ALT 
~ LED_CAPS 
~ LED_LOW_BAT 

 bValue [In] TRUE turns on specified LED. FALSE turns off specified LED. 

Return Values 
Values Description 

TRUE Indicates success. 

FALSE Indicates failure.  

GetMacAddress 
This function returns the MAC address of the BL ident-Handheld, where the high order of the MAC 
address (pHighMac) returns a two-character value (always 48) and the low order of the MAC address 
(pLowMac) a unique ten-character value. For example: 

High Value: 48 
Low Value: 3472888915 

You can use the pLowMac value to uniquely identify each BL ident-Handheld. This number can be helpful 
in an environment (such as Bluetooth) where multiple units can report to a single host device. 

Syntax 
bool GetMacAddress( 
PDWORD pHighMac, 
PDWORD pLowMac ); 

Parameters 
Values Description 

 pHighMac [Out] Specifies a two-character value (always 48). 

 pLowMac [Out] Specifies a unique ten-character value.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates failure. 
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Suspend_Key_Lockout_Off 
This function enables the suspend/resume function. 

Syntax 
bool Suspend_Key_Lockout_Off( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Indicates that you can suspend the unit. 

FALSE Indicates that the function failed.  

Suspend_Key_Lockout_On 
This function disables the suspend/resume function. 

Syntax 
bool Suspend_Key_Lockout_On( 
void 
); 

Parameters 
None 

Return Values 
Values Description 

TRUE Indicates that you cannot suspend the unit. 

FALSE Indicates that the function failed.  

Suspend_Key_Lockout_State 
This function returns the status of the current suspend/resume lockout state 

Syntax 
bool Suspend_Key_Lockout_State( 
PDWORD pdwLockoutState 
); 

Parameters 
Values Description 

pdwLockoutState [Out] Returns the status of the suspend lockout state, where 1 = TRUE and 0 = 
FALSE. 

Return Values 
Values Description 

TRUE Indicates success. 

FALSE Indicates failure. 
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Suspend_Key_Lockout 
This function allows you enable, disable and return the status of the suspend/resume function on the 
On/Off switch 

Syntax 
bool Suspend_Key_Lockout( 
PBOOL pbLockoutState 
); 

Parameters 
Values Description 

pbLockoutState Specifies of the following: 

 
~ [In] LOCKOUT_OFF 
~ [In] LOCKOUT_ON 
~ [Out] LOCKOUT_READ  

Return Values 
Values Description 

TRUE Indicates success. 

FALSE Indicates failure.  

PlayTone 
This function enables you to access the beep driver for various purposes, such as notifying an operator that 
a malfunction occurred or that a process has finished. Parameters that you can define include frequency, 
volume and duration (in milliseconds). 

Syntax 
bool PlayTone( 
int iFrequency, 
int iVolume, 
int iDurationMS 

); 

Parameters 
Values Description 

iFrequency Specifies the beep frequency. Range: 56 to 20000 KHz. 

iVolume Specifies the beep volume. Range: 1 to 100. 

iDurationMS Specifies the beep duration in milliseconds Range 1 to 10000 (10 seconds).  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates failure. 
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Incorporating JETTRFID.dll Functionality 
JETTRFID.dll provides developers in eMbedded C++ 4.0, Visual Basic .NET 2003 and Visual C# .NET 
2003 a method to quickly incorporate RFID functionality for BL ident-Handheld applications. 

The following API calls contained within the JETTRFID.dll allows you to initialize and configure the 
RFID module. It also reads, writes and locks data for the RFID tags supported by the BL ident-Handheld: 

• ChangeBaudRate 

• ClearDataBlocks 

• CloseRFID 

• InitRFID 

• LockDataBlocks 

• ReadTagData 

• ReadTagDataB 

• ReadTagID 

• SetReader 

• SleepMode 

• WakeMode 

• WriteTagData 

• WriteTagDataB 

ChangeBaudRate 
This function enables you to change the RFID module baud rate. When you call this function, the RFID 
module stores the baud rate in its system memory, and then closes and re-opens the COM2 port on the BL 
ident-Handheld with the new baud rate. Because future initializations must match the baud rate setting 
stored in the RFID module, you should store the changed value for reference. The RFID modules’ 
default baud rate is 9600 bps. You can call this function anytime after calling the InitRFID function. 

Syntax 
bool ChangeBaudRate( 
int iBaudRate, 
int iErrorCode 

); 

Parameters 
Values Description 

iBaudRate [In] Specifies of the following baud rates: 9600, 19200, 38400 or 57600 bps. 

iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 

TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer). 
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ClearDataBlocks 
This function clears the data blocks for a specific RFID tag, identified by its tag ID. When you call this 
function, the RFID module writes null characters to the specified data blocks of the tag ID supplied. 
Starting blocks, the number of data blocks, and the block size (4 or 8 bytes) will vary according to the tag 
type. You can only clear 64 bytes of data on any one call to this function. 

Syntax 
bool ClearDataBlocks ( 
BSTR bsTagID, 
RFID_TAGTYPE rtTagType, 

int iStartBlock, int 
iNumBlocks, int 
iErrorCode ); 

Parameters 
Values Description 

bsTagID [In] Unique tag ID. You can retrieve the Tag ID by calling the SetReader and the 
ReadTagID functions. 

 rt Tag Type [In] Specifies of the following tag types: 

 

~ TAGTYPE_00_AUTO_DETECT (Not available for use) 
~ TAGTYPE_01_ISO15693 
~ TAGTYPE_02_ICODE 
~ TAGTYPE_03_TAG_IT 
~ TAGTYPE_04_ISO14443A (Not available at this time) 
~ TAGTYPE_05_ISO14443B (Not available at this time) 
~ TAGTYPE_06_PICO_TAG 

 iStartBlock [In] Starting block number (dependant on tag type). 

 iNumBlocks [In] Number of data blocks to clear (up to 64 bytes). 

 iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  
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CloseRFID 
This function closes the RFID module. When you call this function, it turns off the COM2 port on the 
BL ident-Handheld and auxiliary power to the RFID module. 

Syntax 
bool CloseRFID( 
int iErrorCode, ); 

Parameters 
Values Description 

iErrorCode [Out] Pointer to the error code if this function fails. 

Return Values 
Values Description 

TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  

InitRF ID 
This function enables the RFID module. When you call this function, it opens the COM2 port on the BL 
ident-Handheld at the specified baud rate and turns on the auxiliary power. This function will fail if you use 
a baud rate that does not match the baud rate stored in the RFID module. After initialization, you can 
begin to read and write tag information. See also ChangeBaudRate. 

Syntax 
bool InitRFID( int 
iBaudRate, int 
iErrorCode ); 

Parameters 
Values Description  

iBaudRate [In] Specifies of the following baud rates: 9600, 19200, 38400 or 57600 bps. 

iErrorCode [Out] Pointer to the error code if this function fails.   
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  
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LockDataBlocks 
This function locks a data block for a specified RFID tag, permanently preserving that data contained in that 
block. Starting blocks, the number of data blocks, and the block size (4 or 8 bytes) will vary according to 
the tag type. You can only lock 64 bytes of data on any one call to this function. 

Note: Once you lock a block, you can never write data or erase the contents of that block again. 

Syntax 
bool LockDataBlocks ( 
BSTR bsTagID, 
RFID_TAGTYPE rtTagType, 
int iStartBlock, int 
iNumBlocks, int 
iErrorCode ); 

Parameters 
Values Description 

bsTagID [In] Unique tag ID. You can retrieve the Tag ID by calling the SetReader and the 
ReadTagID functions. 

 rt Tag Type [In] Specifies of the following tag types: 

 

~ TAGTYPE_00_AUTO_DETECT (Not available for use) 
~ TAGTYPE_01_ISO15693 
~ TAGTYPE_02_ICODE 
~ TAGTYPE_03_TAG_IT 
~ TAGTYPE_04_ISO14443A (Not available at this time) 
~ TAGTYPE_05_ISO14443B (Not available at this time) 
~ TAGTYPE_06_PICO_TAG 

 IStartBlock [In] Starting block number (dependant on tag type). 

 iNumBlocks [In] Number of data blocks to lock (up to 64 bytes). 

 iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  
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ReadTag Data 
This function reads data from the data blocks of a specific RFID tag and copies the data into the 
bsTagData buffer. It will return all characters from the tag's data area until it encounters the first null 
character. You can only read 64 bytes of data on any one call to this function. You can only read 64 
bytes of data on any one call to this function. 

Note: If your application requires encrypting and decrypting data, you should do it before writing the data 
and after reading the data. 

Syntax 
bool ReadTagData ( 
BSTR bsTagID, 
RFID_TAGTYPE rtTagType, 
int iStartBlock, int 
iNumBlocks, BSTR 
bsTagData, int 
iBytes 
int iErrorCode 

); 

Parameters 
Values Description 

bsTagID [In] Unique tag ID. You can retrieve the Tag ID by calling the SetReader and the 
ReadTagID functions. 

 rt Tag Type [In] Specifies of the following tag types: 

 

~ TAGTYPE_00_AUTO_DETECT (Not available for use) 
~ TAGTYPE_01_ISO15693 
~ TAGTYPE_02_ICODE 
~ TAGTYPE_03_TAG_IT 
~ TAGTYPE_04_ISO14443A (Not available at this time) 
~ TAGTYPE_05_ISO14443B (Not available at this time) 
~ TAGTYPE_06_PICO_TAG 

 iStartBlock [In] Starting block number (dependant on tag type). 

 iNumBlocks [In] Number of data blocks to read (up to 64 bytes). 
 bsTagData [Out] Pointer to the buffer that contains the data read from the tag. 

 iBytes [In] Number of data bytes in the bsTagData buffer. 

 iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer). 
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ReadTag DataB 
This function reads data from the data blocks of a specific RFID tag and copies the data into the 
bTagData buffer. It will return all characters from the tag's data area including null characters. You can 
only read 64 bytes of data on any one call to this function. 

Note: If your application requires encrypting and decrypting data, you should do it before writing the data 
and after reading the data. 

Syntax 
bool ReadTagDataB ( 
BSTR bsTagID, 
RFID_TAGTYPE rtTagType, 
int iStartBlock, 
int iNumBlocks, 
BYTE bTagData, 
int iBytes 
int iErrorCode 

); 

Parameters 
Values Description 

bsTagID [In] Unique tag ID. You can retrieve the Tag ID by calling the SetReader and the 
ReadTagID functions. 

 rtTag Type [In] Specifies of the following tag types: 

 

~ TAGTYPE_00_AUTO_DETECT (Not available for use) 
~ TAGTYPE_01_ISO15693 
~ TAGTYPE_02_ICODE 
~ TAGTYPE_03_TAG_IT 
~ TAGTYPE_04_ISO14443A (Not available at this time) 
~ TAGTYPE_05_ISO14443B (Not available at this time) 
~ TAGTYPE_06_PICO_TAG 

 iStartBlock [In] Starting block number (dependant on tag type). 

 iNumBlocks [In] Number of data blocks to read (up to 64 bytes). 
 bTagData [Out] Pointer to the buffer that contains the data read from the tag. 

 iBytes [In] Number of data bytes in the bTagData buffer. 

 iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer). 
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ReadTagID 
This function reads the unique tag ID from a RFID tag that enters the module’s RF field. 

Note: You must call the SetReader function prior to calling this function. 

Syntax 
bool ReadTagID ( 
BSTR bsTagID, 
int iBytes 
RFID_TAGTYPE rtTagType, 
int iErrorCode 

); 

Parameters 
Values Description 

bsTagID [Out] Buffer that will receive the data read from the tag. 
iBytes [In] Number of data bytes in the bsTagID buffer. 
rt Tag Type [Out] Returns the tag type when using AUTO_DETECT in the SetReader function. 

Otherwise, the parameter returns zero. 

iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  
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SetReader 
This function sets up the RFID module to read tag IDs (use the ReadTagID function to actually read the 
tags). 

Note: When using loop mode, you can continuously call the ReadTagID function to find tag IDs. In addition, 
you will only need to call this function once until you send another command to the RFID module. 

Syntax 
bool SetReader ( 
RFID_FLAG rfFlag, 
RFID_TAGTYPE rtTagType, 
int iErrorCode 

); 

Parameters 
Values Description 

 rfFlag [In] Flag sent to the reader to indicate one of the following read modes: 

 

~ FLAG_00_SELECT_TAG—the RFID module will just read the first tag 
encountered within its range. 

~ FLAG_01_SELECT_TAG_LOOP—the RFID module will continuously 
read tags within its range (even the same tag several times) until you 
send it another command. 

~ FLAG_02_ANTI_COLLISION—the RFID module will read all tags 
encountered within its range once, storing each tag ID 

~ FLAG_03_ANTI_COLLISION_LOOP— the RFID module will read all 
tags encountered within its range once, storing each tag ID but continue 
to scan for additional tags until you send it another command. 

 rt Tag Type [In] Specifies of the following tag types: 
~ TAGTYPE_00_AUTO_DETECT 
~ TAGTYPE_01_ISO15693 
~ TAGTYPE_02_ICODE 
~ TAGTYPE_03_TAG_IT 
~ TAGTYPE_04_ISO14443A 
~ TAGTYPE_05_ISO14443B 
~ TAGTYPE_06_PICO_TAG 

 iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer). 
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S leepMode 
This function puts the RFID module into sleep mode to conserve power. You can call this function 
anytime after calling the InitRFID function. Any command sent to the RFID module will automatically 
wake the module. You can also use the WakeMode function. 

Syntax 
bool SleepMode( int 
iErrorCode, 
); 

Parameters 
Values Description 

iErrorCode [Out] Pointer to the error code if this function fails. 

Return Values 
Values Description 

TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  

WakeMode 
This function wakes the RFID module from sleep mode. You can call this function anytime after calling 
the InitRFID function. See also SleepMode. 

Syntax 
bool WakeMode( int 
iErrorCode, 
); 

Parameters 
Values Description 

iErrorCode [Out] Pointer to the error code if this function fails. 

Return Values 
Values Description 

TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  
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WriteTag Data 
This function writes the entered data to the tag’s data blocks until it encounters the first null character. It 
automatically calculates the number of data blocks required and fills partially written blocks with null 
characters. You can only write 64 bytes of data on any one call to this function. 

You should use this function when writing null terminated character strings within the 96-character 
ASCII set (decimal values 20 through 127). 

Notes: You can only write 64 bytes of data on any one call to this function. 

If your application requires encrypting and decrypting data, you should do it before writing the data and 
after reading the data. 

Syntax 
bool WriteTagData ( 
BSTR bsTagID, 
RFID_TAGTYPE rtTagType, 
int iStartBlock, 
BSTR bsTagData, 
int iErrorCode ); 

Parameters 
Values Description 

bsTagID [In] Unique tag ID. You can retrieve the Tag ID by calling the SetReader and the 
ReadTagID functions. 

rt Tag Type [In] Specifies of the following tag types: 

 

~ TAGTYPE_00_AUTO_DETECT (Not available for use) 
~ TAGTYPE_01_ISO15693 
~ TAGTYPE_02_ICODE 
~ TAGTYPE_03_TAG_IT 
~ TAGTYPE_04_ISO14443A (Not available at this time) 
~ TAGTYPE_05_ISO14443B (Not available at this time) 
~ TAGTYPE_06_PICO_TAG 

iStartBlock [In] Starting block number (dependant on tag type). 

bsTagData [In] Pointer to the buffer that contains the data written to the tag. 

iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer).  
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WriteTagDataB 
This function writes all the entered data to the tag’s data blocks including null characters. It 
automatically calculates the number of data blocks required and fills partially written blocks with null 
characters. You can only write 64 bytes of data on any one call to this function. 

You should use this function when writing any character within the ASCII character set (decimal values 0 
through 255). 

Notes: If your application requires encrypting and decrypting data, you should do it before writing the 
data and after reading the data. 

Syntax 
bool WriteTagDataB ( 
BSTR bsTagID, 
RFID_TAGTYPE rtTagType, 
int iStartBlock, 
BYTE bTagData, 
int iNumBytesToWrite 
int iErrorCode 

); 

Parameters 
Values Description 

bsTagID [In] Unique tag ID. You can retrieve the Tag ID by calling the SetReader 
and the ReadTagDataB functions. 

 rtTag Type [In] Specifies of the following tag types: 

 

∼ TAGTYPE_00_AUTO_DETECT (Not available for use) 
~ TAGTYPE_01_ISO15693 
~ TAGTYPE_02_ICODE 
~ TAGTYPE_03_TAG_IT 
~ TAGTYPE_04_ISO14443A (Not available at this time) 
~ TAGTYPE_05_ISO14443B (Not available at this time) 
~ TAGTYPE_06_PICO_TAG 

 iStartBlock [In] Starting block number (dependant on tag type). 
 bTagData [In] Pointer to the buffer that contains the data you will write to the tag. 
 iNumBytesToWrite [In] Contains the number of bytes you will write to the bTagData buffer. 

 iErrorCode [Out] Pointer to the error code if this function fails.  
Return Values 

Values Description 
TRUE Indicates success. 

FALSE Indicates otherwise (error code returned though pointer). 
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JETTRFID.dll  Error Codes 
By default, all JETTRFID.dll functions return a Boolean pass/fail (TRUE/FALSE) result. In addition, the 
JETTRFID.dll will return the following error codes to aide in application programming development. 

Initialization 
The RFID module will return the following error codes, if an error occurs during initialization: 

Value Description 
100 Not initialized. 
101 Invalid baud rate. 
102 Could not open COM port. 
103 Could not turn on auxiliary power. 
104 Could not write to COM port. 
105 Could not change baud rate. 
106 Could not initialize (baud rate does not match stored baud rate).  

Parameters 
The RFID module will return the following error codes, if an error occurs while passing function 
parameters: 

Value Description 
200 Invalid flag setting. 
201 Invalid tag type. 
202 Tag ID is empty. 
203 Invalid tag type for read/write command. 
204 Invalid starting block (starting block range is 0–127). 
205 Invalid number of data blocks (data block range is 0–16). 
206 Tag data is empty. 
207 Data byte size cannot be less than one.  

Read/Write 
The RFID module will return the following error codes, if an error occurs while attempting to read, 
write, clear or lock tag data: 

Value Description 
300 No tag ID found in RF field. 
301 Not a valid tag ID, invalid tag type detected. 
302 Could not read tag data. 
303 Invalid starting block (starting block range is 0–127). 
304 Invalid number of data blocks. 
305 Could not set reader command. 
306 Could not write tag data. 
307 Invalid message length. 
308 Could not lock data blocks or data blocks already locked. 
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JETTRFID.dl l  Sample Flow Chart 
The following flow chart depicts how a sample application might access and use the API calls in the 
JETTRFID.dll: 

Figure 5-1: JETTRFID.dll Sample Flow Chart 
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Keyboard Mapping 
JETTkbtool.exe, designed to run on your development system, is a command line utility that creates a 
key map file. This key map file will remap the current BL ident-Handheld keypad configuration 
externally (outside of an application), when the unit boots up. 

During the boot sequence, the BL ident-Handheld searches in the \Windows folder in ascending 
alphanumeric order for existing key map files (identified by their “.RMT” extension). When the BL ident-
Handheld encounters a files of this type, it checks the key map ID number. If the ID number contained 
in the key map file matches the number stored in the BL ident-Handheld’s hardware configuration block, 
the values in that file are used to map to the keypad. After creating your RMT file, you must copy it to the 
SystemCF folder on the BL ident-Handheld and deploy it to the \Windows folder during boot up. See 
Launching Files at Startup for more information. 

Default keypad template files (JET55KEY.TXT, JET31KEY.TXT and JET15KEY.TXT) are included with the 
JETT•ce SDK. Copies of these files as well as configuration notes appear in Appendix C. 

Syntax 
JETTKBTOOL fi lename.ext 

Option Description 
f i lename. ext Specifies the name of the file containing the keypad template. The file name 

must follow MS-DOS 8.3 naming conventions. 
Default file names: 45-key keypad = Jet55key.txt, 30-key keypad = Jet31key.txt 
15-key keypad = Jet15key.txt 

 

Example 
The following example executes JETTKBTOOL using Jet55key.txt as it argument to create the file, 
Jet55key.rmt for a 45-key keypad. 

JETTKBTOOL Jett55key.txt 

Errors Messages 

Message Description 
Unable to open filename.ext. JETTKBTOOL cannot find the specified file. The specified file is 

named incorrectly 

Unable to parse to scan code 
‘XXX’ on NNN 

The entry (XXX) is not a valid keyword on the specified line 
(NNN) 

Invalid line NNN The entry specified on line NNN is either misspelled, not 
allowed or not formatted correctly 
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Tracking Self-Installed Files 
ListFiles.exe is a utility program that enables you to compare the number of files before and after the 
installation of self-extracting software on a BL ident-Handheld. An output file, which contains the 
differences, shows the path and names of the added files, enables you to verify the components of the 
installed software as well as their location. You can also incorporate listed in the output file with the 
contents of FileCopy.F2C to launch the installed software at boot up. 

1. On the BL ident-Handheld, navigate to the Windows folder and double-tap 
ListFiles.exe. The ListFiles.exe dialog box appears. 

 
2. On the menu bar, tap File and select New File List. The Select Output File dialog box appears. 

 
3. Enter the name of the output file (such as before.txt) and tap OK (you should copy the file to 

either System CF or a compact flash card to permanently store the file).ListFiles.exe will then 
display the total number of files found on the BL ident-Handheld. 

 
4. Tap OK to close the Files Found dialog. 

5. Exit ListFiles.exe. 

6. Copy and install the new software on the BL ident-Handheld. 

7. After successfully installing the software, restart ListFiles.exe and following Steps 2 through 4 
create another output file with a different file name (such as after.txt). 

8. On the ListFiles menu bar, tap File and select Compare Lists. The Select Small List dialog box 
appears. 

9. Navigate to the folder that contains the file created in Steps 2 through 4 (i.e., before.txt), select 
it and tap OK. The Select Larger List dialog box appears. 

10. Navigate to the folder that contains the file created in Step 7 (i.e., after.txt), select it and tap 
OK. The Select Output File dialog box appears. 
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11. Enter the name of the output file (such as diff.txt) that will contain the list of differences and 
tap OK. ListFiles.exe will then display the total number of difference found between the first 
and second files. 

 
12. Tap OK to close the Files Found dialog. 

13. Exit ListFiles.exe. 

14. Navigate to the folder that contains the output file (i.e., diff.txt) and double-tap it to view the 
contents. For example: 

 

Launching Files at Startup 
You can create an ASCII text input file to automatically copy files and create folders when booting up the 
BL ident-Handheld. 

During the boot up process, the BL ident-Handheld looks in the \SystemCF folder for the FileCopy.F2C 
file, and if found, opens the file and then parses and executes its contents. 

When the file copy function executes, it creates the FCLog.txt file in the \SystemCF folder. This log file will 
contain any errors encountered during the execution of the FileCopy.F2C file. 

Note: the “FC2” file extension applies to BL ident-Handheld with OS Versions 0.70 and above. Previous versions 
must still use the “txt” file extension. 

F i leCopy.F2C Commands 
Each line in the FileCopy.F2C file must begin with one of the following command line arguments: 

Function Arguments 

Copy File copy <\path\source_file> <\path\file_name> 

Make Directory md <\path\directory> or mkdir <\path\directory> 
 
If a file or directory name includes one or more spaces, the whole path must appear within quotes. For 
example: 

copy \systemcf\helloworld.exe "\program files\helloworld.exe" 

Example 
In the example below, the first line does not require quotes since neither the source path nor the 
destination path include a space character. However, the second and third lines do require quotes 
because the folder name “My App” contains a space character. 

copy \systemcf\mfcce.dll \windows\mfcce400d.dll 
md "\My Apps\" 
copy \systemcf\helloworld.exe "\ My Apps\helloworld.exe" 
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Chapter 6: Troubleshooting 

 
Problem 
Solutions 

My BL ident-Handhelddoes not respond when I press the power 
button. Is the unit in Suspend mode? 
If battery-powered, check the batteries. 
Are all cables connected properly: 

• Is the power supply plugged into an active AC outlet? 
• Is the power connector securely plugged into the BL ident- 

Problem I changed my system settings, but when I turn on the BL ident-Handheld my settings 
are gone. 

Solution You must save the registry after making any system or configuration changes. 

Problem I transferred files to the BL ident-Handheld from my host computer, but when I turn on 
the BL ident-Handheld my transferred files are missing. 

Solution To store transferred files permanently, you must file copy the files into internal flash 
memory or a compact flash card. 

Occasionally, transferred files can be hidden from view, double-tap My Computer, 
select Options from the View menu and clear all boxes. 

Problem I cannot connect to the development system using ActiveSync. 

Solutions Did you install ActiveSync using the Administrator account? 

Check the cable connections. 

Check the serial communications configuration. 

Make sure the correct COM port is available. 

In ActiveSync, check the Connection Settings for the connection type you are using 
(USB, Serial or Ethernet). 

Problem The screen is too light or too dark. 

Solution Adjust the brightness via the brightness control in the Control Panel. 
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Problem The stylus is not responding properly. 

Solution The screen is not calibrated correctly to interpret the screen taps. You need to 
recalibrate the screen. 

Problem The BL ident-Handheld acts slowly. 

Solutions The unit may be short of program memory or storage memory. 

Increase the amount of storage or program memory through the System control in the 
Control Panel. You can also delete any unnecessary files. 
 

Problem I get little or no sound from the BL ident-Handheld. 

Solution Adjust the volume and sound properties via the Volume and Sound control in the 
Control Panel. 

Problem The BL ident-Handheld does not recognize a compact flash or device card. 

Solution The card is not installed or seated properly. 

Reinstall the card. There may be an unstable connection between the card and the BL 
ident-Handheld. 
Remove the card, clean the edge connector with a soft dry cloth, and reinstall the 
card. 

Problem The BL ident-Handheld goes into auto-suspend after a short period of inactivity. 

Solution  As a default, the device will auto-suspend after two minutes of inactivity while 
running on batteries and after thirty minutes of inactivity when running on AC 
power. 
Adjust the power management properties via the Power control in the Control 
Panel. 

Problem No sound is heard when you tap the touch screen or press a key. 

Solution Volume setting is low or turned off. 

Check the volume slider in the Volume & Sound properties dialog box in the 
Control Panel. 
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Appendix A: Specifications 

Power 
 

 
Recharge Voltage: 11 to 18 VDC, 1.5A (North America Only) 
Battery Type: Nickel Metal Hydride Rechargeable (or 6 AA alkaline batteries) 

 
~ Current Rating: 2 Amp Maximum 
~ Voltage: 7.2 Volts 
~ Capacity: 1400 mAh 

Display 
 

 

 

Supertwist Nematic Liquid Crystal TFT with white LED backlight 
Resolution: 320 x 240 pixels QVGA color 
Touch Screen 

Environmental 

 

 

 

 

Operating Temperature: 0°C to +50°C 
Storage Temperature: -25°C to +70°C 
Charging Temperature: 0°C to + 40°C 
Humidity: 5-95% Non-condensing 

CPU 

 

 

 

 

Type: Intel PXA255 processor with XScale technology 
Instruction Set Architecture: ARM v.5TE 
Speed: 200 MHz (400 MHz optional) 
Operating System: Windows CE .NET 4.2 Prof essional 

Memory and Mass Storage 
 

 

 

SDRAM: 64MB 
Internal Compact Flash: 64 MB standard (16MB reserved for OS), upgradeable to 128MB 
Optional: Compact flash card slot 

RFID Module 
 

 

 

Multi-protocol read/write support for 13.56MHz RFID tag types including ISO-15693, Tag-It by 
Texas Instruments, I Code by Philips, GemWave by TagSys, and PicoTag from Inside Contactless 
(see Table 1-1 for specifics). 
Read Range: 3.152-3.546 inches (80-90 mm) 
Output Power Measurement: 22.8 dbm = 200 mW 

User Input 
 Touch Screen 

 Key Pad: 45-Key membrane (9 rows x 5 columns) or 15-key elastomeric (5 x 3) 

 Feedback: Tactile and audible 

 Optional: LED backlighting 
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Indicators 
 5 Modifier Key/Programmable LEDs 

 Charge/Low Battery Indicator (battery-powered units only) 

Interface Capability 
One available serial port configured for RS-232 that can also provide input power (11–18VDC) 
and recharging capability. 
Optional interface connectors (available at time of factory configuration) include the BL 
ident connect system, DE-9 male or female connectors and a six-pin modular connector. 
Interface connections (available at time of factory configuration) can optionally provide output at 5 
VDC to operate peripheral devices. 

Physical Dimensions 
 Height (H): 9.84 Inches (250 mm) 
 Width (W): 4.75 Inches (120.7 mm)        
Depth (D): 2.37 Inches (60.2 mm)  
Weight : 

• Without Batteries: 27 Ounces (765.4 grams) 

• With Alkaline Batteries: 32 Ounces (907.2 grams) 

• With NiMH Batteries: 33 Ounces (935.5 grams) 

 
Specif ications subject to change 
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Appendix B: Signal and Pin Assignments 

BL ident Connect Cables 
Figures B-1 and B-2 list the standard RS-232 signal and pin assignments for the BL ident connect cables. 

Figure 6-2: 91708 Cable (Male DE9) RS-232 Signal and Pin Assignments 

 
 White w/Black Stripe
Pin 1 (Reserved) 
 Blue
Pin 2 (GND) Pin 5 (GND)
 Gray
Pin 3 (RI) Pin 9 (RI) 
 Black
Pin 4 (CTS) Pin 8 (CTS) 
 Violet
Pin 5 (DTR) Pin 4 (DTR)
 Yellow
Pin 6 (TXD) Pin 3 (TXD) 

Brown
Pin 7 (DSR) Pin 6 (DSR)
 Red
Pin 8 (RTS) Pin 7 (RTS) 
 Orange
Pin 9 (DCD) Pin 1 (DCD) 
 White
Pin 10 (PWR)  
Pin 11 (SHIELD)  
 Green
Pin 12 (RXD) Pin 2 (RXD)  

 

Viewed Facing 
Connector 

BLident  Connect DE 9 Connector Power
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Figure 6-3: 91709 Cable (Female DE9) RS-232 Signal and Pin Assignments 

 

1210 Series Modular Interface Cables 
Figure B-3 lists the signal and pin assignments for 1210 series modular cables. 

Figure 6-4: 1210 Series Modular Cable Signal and Pin Assignments 

 
6-Pin Modular Jack 6-Pin Modular Jack 
Pin 1 (Blue) Pin 6 

Pin 2 (Yellow) Pin 5 

Pin 3 (Green) Pin 4 

Pin 4 (Red) Pin 3 

Pin 5 (Black) Pin 2 

Pin 6 (White)                                                                                                                                                      Pin 1 
 
 
 
 
 
_________________________________________________________________________________________ 
 
 
 
 

 

 

Viewed Facing 
Connector 

DE 9 Connector Power 
White w\Black Stripe 

Gray 

Red 

Orange 

Green 

Yellow

JETT• Connect 

Pin 1 (Reserved)  
Pin 2 (GND) 

Pin 3 (RI) 

Pin 4 (CTS) 

Pin 5 (DTR) 

Pin 6 (TXD) 

Pin 7 (DSR) 

Pin 8 (RTS) 

Pin 9 (DCD) 

Pin 10 (PWR)  

Pin 11 (SHIELD) 

Pin 12 (RXD) 

Pin 5 (GND) 

Pin 9 (RI In) 

Pin 7 (CTS In) 

Pin 1 (DTR Out) 

Pin 2 (TXD Out) 

Pin 6 (DTR Out) 

Pin 8 (RTS Out) 

Pin 4 (DSR/DCD In) 

Pin 3 (RXD In) 
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Modular  Cable Adapters  
Pin descriptions assume connection through reversing cables (1210-7, 1210-15) to BL ident-
Handheld. 

CELAT-P Adapter 
Figure B-4 lists the signal and pin assignments for the CELAT-P adapter. 

Figure 6-5: CELAT-P Adapter 

Pin 1

6-Pin Modular Jack 

Pin 1 (Blue) 
Pin 2 (Yellow) 
Pin 3 (Green) 
Pin 4 (Red) __ 
Pin 5 (Black) 
Pin 6 (White) 

Null Modem Cable 

Viewed Facing 
Connector 

Pin 5 (Common) 

Pin 2 (Data Out) 
Pin 3 (Data In) 
Pin 1 (CTS) 
Pin 6 (RTS) 
Pin 8 (Handshake Out) 
Pin 7 (Handshake Out) 
Pin 4 

Pin 9 (RI) 

Figure B-5 lists the signal and pin assignments for TURCK’ 14375 DE-9 Female to DE-9 Female null 
modem cable. Please note that this cable differs from standard null modem cables in that it use Pin 9 for 
input power for the BL ident-Handheld. 

Figure 6-6: DE-9 Female to DE-9 Female Null Modem Cable 

 
Viewed Facing 

Connector 

 

 

 

Female DE9 Connector 
Pin 1 (Blue) 

Pin 2 (Green) 
Pin 3 (Yellow) 
Pin 4 (Orange) 

Pin 5 (Gray) 

Pin 6 (Blue) 

Pin 7 (Red) 

Pin 8 (Violet) 

Pin 9 (Brown) 

Female DE9 Connector 
Pin 1 
Pin 2 
Pin 3 
Pin 4 
Pin 5 
Pin 6 
Pin 7 
Pin 8 
Pin 9 

Power Jac
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Appendix C: Keyboard Mapping Files 

Keyboard Mapping Files Notes 
The following table lists the allowable values and the names of allowable values that you can map to a 
keypad. 

Table 6-1: Allowed Values in Key Map Files 

A V CARET F9 NUMPAD1 SEMICOLON 
B W CLEAR F10 NUMPAD2 SHIFT 
C X COLON F11 NUMPAD3 SLASH 
D Y COMMA F12 NUMPAD4 SPACE 
E Z CONTROL FUNCTION NUMPAD5 STAR 
F ( DELETE HASH NUMPAD6 SUBTRACT 
G ) DOLLAR HOME NUMPAD7 TAB 
H [ DOUBLEQUOTE INSERT NUMPAD8 TILDA 
I ] DOWN LEFT NUMPAD9 UNDERLINE 
J { END KEY0 PAGEDOWN UP 
K } EQUAL KEY1 PAGEUP USER_DEF1 
L < ESCAPE KEY2 PAUSE USER_DEF2 
M > EXCLAMATION KEY3 PERCENT USER_DEF3 
N ADD F1 KEY4 PERIOD USER_DEF4 
O ALT F2 KEY5 PIPE USER_DEF5 
P AMPERSAND F3 KEY6 PRINT USER_DEF6 
Q AT F4 KEY7 QUESTION USER_DEF7 
R BACKQUOTE F5 KEY8 QUOTE USER_DEF8 
S BACKSLASH F6 KEY9 RETURN USER_DEF9 
T BACKSPACE F7 NUMLOCK RIGHT USER_DEF10 
U CAPSLOCK F8 NUMPAD0 SCROLL WINMENU  

Scan codes “USER_DEF1” through “USER_DEF10” can produce some proprietary action, such as 
backlight adjustment, display rotation, etc. For each user-defined key-function (except as noted below), you 
must supply the appropriate code in the keyboard driver to produce the desired effect. "USER_DEF3" 
defines the Backlight+ key and "USER_DEF4" defines the Backlight– key. 

The "FUNCTION" keyword identifies those function accessed through the "2nd" key. The “RETURN" 
keyword identifies the "ENTER" key. The "WINMENU" keyword produces the Windows "Start" menu. 

The number in COLS must always be set to five regardless of the actual number of columns (applies to 
15-key keypads as well). 

Do not change the ID number, it must match the number stored in the BL ident-Handheld’s 
hardware configuration block. 
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45-Key Key Map 
  # 55 Key JettCE keyboard for P/N 11406 Rev A. keypad 
# The keyword "FUNCTION" is used for the "2nd" key. 
 # The keyword "RETURN" is used for the "ENTER" key. 

                         # "USER_DEF1" defines the Contrast+ key 
                         # "USER_DEF2" defines the Contrast- key 
                         # "USER_DEF3" defines the Backlight-INCREASE key 
                         # "USER_DEF4" defines the Backlight-DECREASE key 
                         # "WINMENU" produces the Windows "Start" menu. 

                         # The line and the end of the line 
                          ROWS 11 
                          COLS 5 

                         # The id of the keyboard. 
                          ID 55 

   

# The basic scan codes. 
# Row,Col,Scan Code 

   

SCANCODE 0, 0-> A SCANCODE 0, 1 -> B SCANCODE 0, 2 -> C
 SCANCODE 0, 3-> D SCANCODE 1, 0 -> E SCANCODE 1, 1 -> F
 SCANCODE 1, 2-> G SCANCODE 1, 3 -> H SCANCODE 2, 0 -> I 
 SCANCODE 2, 1-> J SCANCODE 2, 2 -> K SCANCODE 2, 3 -> L
 SCANCODE 3, 0-> M SCANCODE 3, 1 -> N SCANCODE 3, 2 -> O
 SCANCODE 3, 3-> P SCANCODE 4, 0 -> Q SCANCODE 4, 1 -> R
 SCANCODE 4, 2-> S SCANCODE 4, 3 -> T SCANCODE 5, 0 -> U 
 SCANCODE 5, 1-> V SCANCODE 5, 2 -> W SCANCODE 5, 3 -> X
 SCANCODE 6, 0-> Y SCANCODE 6, 1 -> KEY7 SCANCODE 6, 2 -> KEY8
 SCANCODE 6, 3-> KEY9 SCANCODE 7, 0 -> Z SCANCODE 7, 1 -> KEY4 
 SCANCODE 7, 2-> KEY5 SCANCODE 7, 3 -> KEY6 SCANCODE 8, 0 -> PERIOD
 SCANCODE 8, 1-> KEY1 SCANCODE 8, 2 -> KEY2 SCANCODE 8, 3 -> KEY3 
 SCANCODE 9, 0-> BACKSPACE SCANCODE 9, 1 -> SPACE SCANCODE 9, 2 -> KEY0 
 SCANCODE 9, 3-> RETURN SCANCODE 10, 0 -> SHIFT SCANCODE 10, 1 ->

FUNCTION    
SCANCODE 10, 2 -> CONTROL SCANCODE 10, 3 -> ALT SCANCODE 10, 4 -> ESCAPE  
# Table 0 is always the unshifted values. 
TABLE 0, basic, UNSHIFTED 
TABLE 1, func, FUNCTION 
TABLE 2, shift, SHIFT 

# Func remapping table. 
REMAPPING func, A -> DELETE 
REMAPPING func, C -> PAGEDOWN 
REMAPPING func, E -> CAPSLOCK 
REMAPPING func, G -> CLEAR 
REMAPPING func, I -> { 
REMAPPING func, K -> PAUSE 
REMAPPING func, M -> BACKTAB 
REMAPPING func, O -> COLON 
REMAPPING func, Q -> USER_DEF2 
REMAPPING func, S -> HASH 
REMAPPING func, U -> USER_DEF4 
REMAPPING func, W -> WINMENU 
REMAPPING func, Y -> F11 
REMAPPING func, PERIOD -> BACKSLASH 
REMAPPING func, KEY8 -> F8 REMAPPING 
func, KEY4 -> F4 REMAPPING func, KEY6 -
> F6 

REMAPPING func, B -> PAGEUP 
REMAPPING func, D -> INSERT 
REMAPPING func, F -> HOME 
REMAPPING func, H -> SCROLL 
REMAPPING func, J -> TILDA 
REMAPPING func, L -> } 
REMAPPING func, N -> CARET 
REMAPPING func, P -> TAB 
REMAPPING func, R -> PIPE 
REMAPPING func, T -> USER_DEF1 
REMAPPING func, V -> COMMA 
REMAPPING func, X -> USER_DEF3 
REMAPPING func, Z -> F12 
REMAPPING func, KEY7 -> F7 
REMAPPING func, KEY9 -> F9 
REMAPPING func, KEY5 -> F5 
REMAPPING func, KEY1 -> F1 
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REMAPPING func, KEY2 -> F2  
REMAPPING func, KEY0 -> F10 

# Shift remapping table.  
REMAPPING shift, A -> LEFT 
REMAPPING shift, C -> DOWN 
REMAPPING shift, E -> <  
REMAPPING shift, G -> UNDERLINE 
REMAPPING shift, I -> (  
REMAPPING shift, K -> SEMICOLON 
REMAPPING shift, M -> [  
REMAPPING shift, O -> BACKQUOTE 
REMAPPING shift, Q -> AMPERSAND 
REMAPPING shift, S -> QUOTE 
REMAPPING shift, U -> SUBTRACT 
REMAPPING shift, W -> EQUAL 
REMAPPING shift, Y -> PERCENT 
REMAPPING shift, PERIOD -> DOUBLEQUOTE 
#REMAPPING shift, KEY8 ->  
#REMAPPING shift, KEY4 ->  
#REMAPPING shift, KEY6 ->  
#REMAPPING shift, KEY2 ->  
#REMAPPING shift, KEY0 -> 

30-Key Key Map 
                          # 31 Key JettCE keyboard definition file 

 # The keyword "FUNCTION" is used for the "2nd" key. 
 # The keyword "RETURN" is used for the "ENTER" key. 

                          # "USER_DEF1" defines the Contrast+ key 
                          # "USER_DEF2" defines the Contrast- key 
                          # "USER_DEF3" defines the Backlight-INCREASE key 
                          # "USER_DEF4" defines the Backlight-DECREASE key 
                          # "WINMENU" produces the Windows "Start" menu. 

                          # The line and the end of the line 
                          ROWS 10 
                          COLS 5 

                          # The id of the keyboard. 
                           ID 31 

  

# Table 0 is always the unshifted values. 
TABLE 0, basic, UNSHIFTED 
TABLE 1, shift, SHIFT 

# The basic scan codes. 
# Row,Col,Scan Code 

   

SCANCODE 0, 0 -> A SCANCODE 0, 1 -> B SCANCODE 0,2 -> C
SCANCODE 1, 0 -> D SCANCODE 1, 1 -> E SCANCODE 1,2 -> F
SCANCODE 2, 0 -> G SCANCODE 2, 1 -> H SCANCODE 2,2 -> I
SCANCODE 3, 0 -> J SCANCODE 3, 1 -> K SCANCODE 3,2 -> L
SCANCODE 4, 0 -> M SCANCODE 4, 1 -> N SCANCODE 4,2 -> O 
SCANCODE 5, 0 -> P SCANCODE 5, 1 -> Q SCANCODE 5,2 -> R
SCANCODE 6, 0 -> S SCANCODE 6, 1 -> T SCANCODE 6,2 -> U
SCANCODE 7, 0 -> V SCANCODE 7, 1 -> W SCANCODE 7,2 -> X
SCANCODE 8, 0 -> Y SCANCODE 8, 1 -> Z SCANCODE 8,2 -> ESCAPE 
SCANCODE 9, 0 -> SHIFT SCANCODE 9, 1 -> SPACE SCANCODE 9,2 -> RETURN 

REMAPPING func, KEY3 -> F3 

REMAPPING shift, B -> UP 
REMAPPING shift, D -> RIGHT 
REMAPPING shift, F -> END 
REMAPPING shift, H -> >  
REMAPPING shift, J -> EXCLAMATION 
REMAPPING shift, L -> )  
REMAPPING shift, N -> QUESTION 
REMAPPING shift, P -> ]  
REMAPPING shift, R -> AT 
REMAPPING shift, T -> DOLLAR 
REMAPPING shift, V -> SLASH 
REMAPPING shift, X -> ADD 
REMAPPING shift, Z -> STAR 
#REMAPPING shift, KEY7 -> 
#REMAPPING shift, KEY9 -> 
#REMAPPING shift, KEY5 -> 
#REMAPPING shift, KEY1 -> 
#REMAPPING shift, KEY3 -> 
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# Shift remapping table. 
REMAPPING shift, A -> LEFT REMAPPING shift, B -> DOWN 
REMAPPING shift, C -> RIGHT REMAPPING shift, D -> SUBTRACT 
REMAPPING shift, E -> UP REMAPPING shift, F -> ADD 
REMAPPING shift, G -> TAB REMAPPING shift, H -> QUESTION 
REMAPPING shift, I -> COMMA REMAPPING shift, J -> BACKSLASH 
REMAPPING shift, K -> COLON REMAPPING shift, L -> SLASH 
REMAPPING shift, M -> USER_DEF4 REMAPPING shift, N -> STAR 
REMAPPING shift, O -> USER_DEF3 REMAPPING shift, P -> KEY7 
REMAPPING shift, Q -> KEY8 REMAPPING shift, R -> KEY9 
REMAPPING shift, S -> KEY4 REMAPPING shift, T -> KEY5 
REMAPPING shift, U -> KEY6 REMAPPING shift, V -> KEY1 
REMAPPING shift, W -> KEY2 REMAPPING shift, X -> KEY3 
REMAPPING shift, Y -> ALT REMAPPING shift, Z -> KEY0 
REMAPPING shift, ESCAPE -> PERIOD REMAPPING shift, SPACE -> BACKSPACE 

15-Key Key Map 
                                       # Copyright (c) 2003 TURCK Corporation. All rights reserved. 
                         # File: JET15Key.txt 
                         # 

   

                         # 15 Key JETT.ce keyboard, REV 1 
# The keyword "FUNCTION" is used for the "2nd" key. 
 # The keyword "RETURN" is used for the "ENTER" key. 

                         # "USER_DEF1" defines the Contrast+ key 
                         # "USER_DEF2" defines the Contrast- key 
                         # "USER_DEF3" defines the Backlight-On key 
                         # "USER_DEF4" defines the Backlight-Off key 
                         # "WINMENU" produces the Windows "Start" menu. 

                         # The number of rows and columns. 

   

# Note: COLS MUST ALWAYS be a 5 
ROWS 5 
COLS 5 

     

# The id of the keyboard. 
ID 15      

# The basic scan codes. 
# Row,Col,Scan Code 

     

SCANCODE 0, 0 -> TAB SCANCODE 0, 1-> UP SCANCODE 0,2 -> ALT
SCANCODE 1, 0 -> LEFT SCANCODE 1, 1-> BACKSLASH SCANCODE 1,2 -> RIGHT
SCANCODE 2, 0 -> SUBTRACT SCANCODE 2, 1-> DOWN SCANCODE 2,2 -> ADD
SCANCODE 3, 0 -> ESCAPE SCANCODE 3, 1-> PERIOD SCANCODE 3,2 -> RETURN 
SCANCODE 4, 0 -> FUNCTION SCANCODE 4, 1-> CONTRO SCANCODE 4,2 -> SPACE  

# Table 0 is always the unshifted values. 
TABLE 0, basic, UNSHIFTED 
TABLE 1, func, FUNCTION 
TABLE 2, shift, SHIFT 
 
# func remapping table. 
REMAPPING func, TAB    -> KEY1 REMAPPING func, UP -> KEY2 
REMAPPING func, ALT -> KEY3 REMAPPING func, LEFT -> KEY4 
REMAPPING func, BACKSLASH       -> KEY5 REMAPPING func, RIGHT -> KEY6 
REMAPPING func, SUBTRACT -> KEY7 REMAPPING func, DOWN -> KEY8
REMAPPING func, ADD -> KEY9 REMAPPING func, ESCAPE -> USER_DEF4 
REMAPPING func, PERIOD -> KEY0 REMAPPING func, RETURN -> 
USER_DEF3 
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#REMAPPING func, FUNCTION ->  REMAPPING func, 
CONTROL -> WINMENU 
REMAPPING func, SPACE -> BACKSPACE 
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